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Starting something new can be daunting. Learning a skill or
mastering a new piece of hardware is tough. Even tougher if
you have no-one at hand to help. Conversely as the complexity
of our consumer technology increases, the size of the requisite
instruction manual decreases or in some cases it simply disappears.
At numerous times in our lives we have all been“beginners’, there
is no shame in that fact and rightly so. How many times have you
asked aloud, “What does this button do?”.“Why doesn’t that work?”.
“What do you mean it doesn’t do that?”.“HELP!". At the start of any
new journey or adventure we are all beginners but fortunately for
you we are here to stand beside you at every stage.

Over this extensive series of titles we will be looking in great depth
at the latest consumer electronics, software, hobbies and trends
out of the box! We will guide you step-by-step through using all

aspects of the technology that you may have been previously
apprehensive at attempting. Let our expert guide help you build
your technology understanding and skills, taking you from a novice
to a confident and experienced user.

Over the page our journey begins. We would wish you luck but
we're sure with our support you won't need it.
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. New for macOS 10.15: Catalina
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MacBook Pro

Can You Run —
macOS Catalina? m ;I H —

Older Macs cannot be updated to the new MacBook Early 2015 or newer iMac Late 2012 or newer
operating system, so if you want to MacBook Air  Mid 2012 or newer iMac Pro 2017 or newer
upgrade your Mac to macOS Catalina, it MacBook Pro  Mid 2012 or newer Mac Pro 2013 or newer
must be one of the following models: Macmini  Late 2012 of newat
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New for macOS 10.15: Catalina ]

The Music App
AAIOS, | Tunes

New for Catalina

=

With the introduction of macOS$10.15: Catalina, Apple abandons that old
workhorse iTunes and replaces it with Music, an app that will already

be familiar to iPad and iPhone owners. It's another step towards greater
integration between the Mac and its smartphone and tablet stable mates.

Catalina’s new Music app is
very similar to the one found
on the iPhone or the iPad, but
if you’re familiar with iTunes,
you shouldn’t have too many
problems getting started.

1 When you're using the Music
app, the top bar gives you
pull-down menus offering controls and
options. It's warthwhile familiarising

yourself with them.

The Search field: Completion

suggestions are offered as you
type, and results can be limited to
Apple Music, or your on-Mac library, as
vou wish. Results include artists, songs,
albums and more.

3 When you're playing music, this
icon is replaced by the album art.
Click on it to switch to the mini player,
which shows the album art and controls
only, and takes up much less room on
the screen. Close the mini player to
return to the full Music window,

The controls: These are, in

turn, Previous track, Play/Pause,
Next track. The line underneath lets you
scrub through the track. As we're not
playing anything, the controls are
currently greyed.

The volume slider: Click and
drag the dot, and move it left and
nght to change the volume,

The left icon opens a sidebar

showing the lyrics to the current
track. The right icon shows you what's
next. Drag the pointer over the list and you
can remove tracks you'd rather not play:

8 | wwwbdmpublications.com
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7 Apple Music controls: If you
have an Apple Music account, For
You is the main page, offering suggestions
of music you might like and showing what
you played recenthy. Browse is great for
finding new music, and Radio gives
access to streaming stations.

This is the For You page, your
gateway to the Apple Music
streaming service.

EMMUsIC ; -
Favourites - I3 This is the gateway to your Music
Mix - S | social network. Click on it and you

=~ can find out what sounds your friends
are listening to, and discover and enjoy
new music together.

These are the options for your
Library, that is, music you've
installed on your Mac. It can be arranged
into Artists, Albums, or Songs, and there
are sections for music you've recently

added and music videos.

Al the top of the For You page is New

Music, a playlist made up of tracks
chosen for you based on previous plays,
and a mix of your Favourites, tunes you play
a lot. Click the chevrons for other mixes.

These are your playlists. The top

ones are Smart Playlists, which
add songs automatically according to
rules, and the lower ones are playlists you
build yourself,

: : .' _ AR N\ 13 This is a round-up of music you've
NAHEIV - = e |28 recently streamed. Scroll this page
VE N up for more suggestions, again based
on previous listens,

Click this link to see a wider range
of music you've recently played.
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ﬂ New for macOS 10.15: Catalina ]

Signing Up for Apple Music
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With an Apple Music account, you can stream from 50 Click Start Trial and you're asked what sort of an

million songs for a set monthly fee. To sign up for an account you want. The first three months are free, but
account, click on For You in the left-hand sidebar. You can then after that it's £9.99/$9.99/9.99 € for an individual. Choose an
click Learn More to read about Apple Music, or Try It Now account, and click Start Trial to begin.
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3 You must then sign in to your Apple ID, or if you don't There then follows a series of screens inviting you to

have one, create a new one with the button at the foot of indicate what genres of music you like and then what
the pop-up window. Enter your Apple ID email address, then bands. Follow the on-screen instructions and click the bubbles.
your password, and then proceed to the next step. When you're done, you're ready to enjoy Apple Music.

Changing or Cancelling Your Subscription

- - — & = I . — @ =
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If yvou want to cancel your Apple Music subscription, first On the next page, you're shown your active
of all, click Account in the top bar and select View My subscriptions. Click on Apple Music’s Edit link, and on
Account. You're taken to your account page. Scroll down to the next page, you can change your subscription to a different
Subscriptions (under Settings) and click the Manage link one (individual, family or yearly) or cancel it altogether
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Using Apple Music
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1 Browse or search for the artist, album, or track to which you

want to listen. Here we're locking at an aloum. Click Play to
play it in its entirety, or Shuffle to play the tracks in a random order.
Tracks marked with an 'E' in a bax have explicit lyrics.
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3 Click the three-dots icon on the right above the tracks for
a menu. Here you can add the album to a playlist or
create a new one, share it with your friends, like or dislike the
album as a whaole, or create a station based on its artist.
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Apple Music i1s all about helping you to find music you
enjoy listening to. When viewing an album, you can scroll
up and other titles by the artist in question are shown. Click on
one to open it in the main window, click the chevron to see more.
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Music controls such as Play and Pause are found at the top

of the window: To identify tracks on an album you
especially like, hover the pointer over them, and click the star to
their left; it becomes a heart. To change your mind, click the heart.
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Hover the pointer over a track to reveal a three-dots icon,
offering a similar menu that applies to that track alone.
You can also play the track by clicking the Play icon that
appears when you hover the mouse/trackpad pointer over it.

Browse

Towders' & HEx

B The Browse section offers tracks, artists, albums, and
playlists based on Apple Music editors’ choices and new
releases. It also offers current charts for various countries. The
Radio section lets you listen by station or genre, and more.
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New for macOS 10.15: Catalina

Importing CDs
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Do Fact ask ma sgain

You can import your CD collection to your Mac, where it
appears in the Library section of the Music app. If you
don't have a built-in CD drive, connect an external drive. Slot in
a CD, and you're asked whether you want to import it.
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3 Once you've successfully imported your album, don't

forget to click on the Eject button on the left side-bar.

Your CD pops back out so you can store it safely away. The
process of ripping a CD to iTunes doesn’t harm the disc.

Other Music Features
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You see the track listing of the album appear. The progress
bar at the top shows you each track being copied, while a
green lick next 1o each track tells you which songs have already
finished. It takes a few minutes to np an entire CD to iTunes.
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You can play a CD on your Mac without ripping and

importing it. Just slot it into your internal or external CD
drive, and it appears in the Music app's left-hand sidebar. Click
on it and the tracks appear in the main Music window.

Mini Player

When playing a song, click the album cover at the top of the
Music window to minimise the app into the Mini Player. Hover
over the Mini Player window to see the controls. Click the X in
the top-left corner to switch back to the full Music window.
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The Equaliser

On the keyboard, press ALT-CMD-E or go to the Window

top-bar menu to select the equaliser. This lets you adjust the
sound. You can either move the sliders yourself, or choose a
preset from the pull-down at the top of the equaliser window:




Shuffle & Repeat.

“ b=
0:02

When listening to an album, playlist or mix in Music, next
to the controls are the Shuffle and Repeat icons. Shuffle
(left) plays the tracks in a random order, while Repeat

(right) causes your list to start again from the beginning
when finished.

Music + Friends.

For You K]

g oY
| o l R
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Music + Friends
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Click For You, in the left sidebar, then click the icon or
picture in the top-right. A pop-up window for Music +
Friends appears. You can take a quick tour to see what it
does if you wish, or click Get Started to begin.

The Visualiser

The Visualiser is found under the Window menu, or by pressing
CMD-T. It gives you a visual show which ebbs and flows in time
with the music. Press ESC to quit it. Switch between a regular
and classic Visualiser in Window = Visualiser Settings.

O oMm O 3R 0

Music =~

If you click the Repeat icon twice, it displays a small
number ‘1" to the right and above it, as you can see here.
With this in place, it's only the individual track you're
currently listening to that repeats, when it has finished, not
the entire album.

For You
. Find & follow

friends

Add a name and usemame, and an optional photo. You're
then invited to follow friends who also have Apple Music.
On the next screen, you can choose whether anyone can
follow you or only those you approve.

A Cheaper Subscription.

Edit Subscription

Apple Music Membership

If you pay annually for your Apple Music subscription, you
get 12 months for the price of ten. In the top bar, select
View My Account from the Account menu, and next to
Subscriptions click Manage. Choose to edit your Apple
Music subscription, then select the one-year option.

wwwbdmpublications.com | 13




New for macOS 10.15: Catalina ]

TV App
For Movies and Shows

New for Catalina = ™

The TV app has long been a popular means of buying and watching
television shows and movies on iOS, and now it's come to the Mac. If you've
already bought video media on the iTunes Store, in macOS Catalina, you'll
find it in the TV app. How does it work? Let's find out.
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Open the TV app, and click on the Account menu in the

top bar. If you're not signed into vour Apple account,
select Sign In and enter your Apple |ID and Password in the
fields provided, then click the Sign In button below them.
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The Films and TV Programmes tabs take you to
movies, and TV shows respectively, available to buy
and/or rent. TV shows can be bought individually or on a
per-series basis; scroll up for available episodes.

14 |

o T

"“Film EdR  Walen View Contmie  Aooouml | Wenoow  Heln ol 1

Up Hext

I 7 o) @ s Sun £ Gep 2000

&
g

'What 10 Watch
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Look at the tabs at the top of the window. Watch Now is
the TV app’s front page, showing movies and TV shows
you've previously bought alongside those available to buy or
rent from the app. Scroll up for more suggestions.
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The Kids tab is, unsurprisingly, for children's
programmes. Again, click a show, and scroll up to see
which episcdes are available, Click the triangle next to the
Season number and you can switch to a different season.
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The Library tab takes you 1o your collection of movies Hover the mouse pointer over a movie or TV show in your

and shows, those you've purchased previously. In the left library and you get these icons. Click on the Play icon to
hand sidebar, you can view according to when you added play it. The cloud with the arrow on it lets you download it for
them, films only, TV only, or according to genre. later viewing. This is essential if you watch offline.

vé Click on the Three-dots icon, found by hovering over a When locking at a movie to buy or rent, scroll up and you
show, and you gel a pop-up menu. This lets you might find a trailer. These, of course, can be viewed for
download the show, mark it as watched or unwatched, add it free. The Add To Up Next button adds them to your Up Mext
to a playlist, get an interesting information window and more. list, which is found at the top of the Watch Mow screen.
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If you choose to buy or rent a show, or film, you need to When watching a show, move the mouse pointer for
sign into your Apple ID account. You're then asked if contrals. These include pause/play, skip forward or
you're sure, Rented media is removed 30 days after renting it, backward, close the viewing window, add subtitles, and watch

or 48 hours after you start watching it, whichever is sooner. the show in a small window that floats on top of the desktop.
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New for macOS 10.15: Catalina ]

©

New for Catalina =~

Podcasts App
Listen and Subscribe

With macOS Catalina, the iTunes application has been abandoned and
replaced by three new apps; TV, Music and Podcasts. The Podcasts app
lets you find audio programmes that interest you and download, listen to
and subscribe to them. Most podcasts are free too.

Ll Search

Apple Podcasts
[-) Listen Now

() Broy 8
B} Top Charts
Library

o Recently Updated
) shows

E Episodes
a Downloaded

These are your basic
playing controls. The
ican in the centre plays and
pauses the podcast, and
those either side of it skips
back 15 seconds or forwards
30 seconds respectively.

The currently playing

podcast. Hover over it
for a scrub line showing
details such as how long it is
and how much has played,
and a three-dots icon giving
access to a menu offering
various options such as Add
To Library or Mark as Played.
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sinister to the surreal.

The volume slider. The

volume for the
Podcasts app can be set
independently of the system
volume, which is found in the
menu bar atop the desktop.

The information icon.
Click it to show and
hide a sidebar containing
programme notes about the
currently open Podcast.

This icon reveals and
conceals another
sidebar, this time showing a

list of what's coming up next.

Trailer

o ATURDAY
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among Ls will be exclusive

available on Pat

Episodes

The search field. You

can search podcasts
stored in your library or all
podcasts available through the
app. You can search for titles,
names, content and more.

7 The back button. We're
currently looking at a
specific podcast. Clicking this
icon would take us back to the
page that brought us here.

B In the left-hand sidebar,
click Listen Now for a list
of the latest podcasts released

In shows to which you subscnbe.
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They Walk Among Us - UK
True Crime
They Walk Among Us
TRUE CRIME - 2017=2019 *x W W W I 4.5, 22K RATINGS

Thay Walk Among Us is an award-winning weekly UK true
crime podcast covering a broad range of cases from the

rean. Tha podcast has come a

< SUBSCRIBED ey

more

Click on individual podcasts to
go to that show's page. You can
browse for new podcasts or
scan the latest charts for most

popular podcasts.

The Library section of

the sidebar shows you
the podcast content saved on
vour mac divided into Shows
and Episodes, along with
podcasts you have downloaded
for offline listening.

10 The main window with
all the information of
the Podcast you're browsing.




Using the Podcasts App

Friday Night Comedy from BBC
Radio 4
BEC Radio 4
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To subscribe to a podcast, and have new episodes

automatically downloaded to your Mac to enjoy later,
browse or search for a show might like and then click the
+Subscribe button, or use the three-dots icon to its right. You
can use this three-dots icon to unsubscripe too,

1 Hoarws [fae 335 Sapirshe 5H &

Fewa Duir fth Sepiembes 70T

B Tre Maws Duig Fri 1 Bapoemipes 2019

T he Flirws Do B8 Saobhamibe: 2NN

Ty Flpws Quiiy B0th dasgens FOH

3 When looking at a list of episodes in a specific podcast,

hover your pointer over one for a Play button, which lets
yau play it without downloading. Click the title for more
information, the Plus icon to download whether you're
subscribed or not and the three dots for options.
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Open the Podcasts app’s Preferences window and you
can configure the app to your own needs. You can
change the skip buttons’ timing from the default 30 or 15
seconds, set headphone controls, choose whether to play one
episode at a time or continuously, and more.

Podcasts @

Friday Night Comedy from BBC
Radio 4
HELC Hadio 4
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Mty Episodes
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To play an episode of a show to which you've
subscribed, click on Shows in the left-hand sidebar, click
the podcast you want to hear and click the Play Episode button
for the latest show. Click See All Episodes at the foot of the
page for a list of other available episcdes.
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Don't miss the Browse options. Click the Browse option

in the left sidebar and scroll up to see Categories, which
groups podcasts according to genre. Click See All for the full
range. Keep scrolling for curated collections, editors’ picks,
new seasons and lots more besides,

Advanced

Camial Pligheck Sdvansad

Library: [ Syne subscriptions across devices
B Automatically delete played episodes
Show Sin Suggestions in App

The Advanced tab in the Preferences window gives
access to some very important controls, You can choose
whether or not to sync your subscriptions across your Apple
devices, automatically delete episodes you've already listened
to and show Sin suggestions too.
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New for Catalina

Screen Time
Monitor Mac Use

Screen Time Is a great feature that was introduced to the iPad and the
IPhone last year, but comes to the Mac with macOS 10.15: Catalina. You
can use it to check what you've been doing on your Apple devices, and for
how long, as well as to limit your children’s computer time. Let's take a look.

First of all, open System Preferences from the Apple
menu, or the Dock, and open the Screen Time
preference pane. It's in the first section of preferences; look for
the purple circle with the Hourglass icon on it.

Projerences bl Waew  Wesdow  Helo

B In the left sidebar, click App Usage. This shows how much
time you've spent on your Mac today as a figure, and over
the week, as a graph. Below is a list of apps and websites you
used, and for how long you've used them for.
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Click on Categories and the bottom panel shows what
you've been using your Mac for, such as Entertainment or
Ssocial Networking instead of apps. Hover over a category or an
app and you see an hourglass.
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Click this hourglass and you can limit the time you
spend on that app or category. You can set a single
per-day time limit, or a custom schedule, so you can (for
example) allow more time on a weekend than a weekday.
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Click Motifications on the left-hand sidebar and you're
told how many notifications you've received that day, and
from what apps. Click the date in the top panel and you can
lock at the week instead of the day.
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7 The Downtime section lets you plan for time away from the

screen. During downtime, only apps you choose to allow at
any time are accessible. You can set downtime on an every-day
basis, ar customise according to the days of the week,
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Always Allowed sets apps that can be used even during
downtime. For example, if you want access to emalil at all
times, check Mail. Content and Privacy restricts explicit content
such as websites, explicit language and media.
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Pickups is the number of times you've interacted with
specific apps on your Mac, that is, actually used them
instead of just opening them. Again, you can look at today or the
entire week. Click an app to see the average per-day:
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App limits sets downtime on a per-app or a per-category
basis, and again can apply every day or customised
according to the day of the week. Five minutes before downtime,
a nofification appears saying you're almost out of time.
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Click Options (bottom left) and check 'Share across
devices' to have your settings apply across all your Apple
gear. Click Use Screen Time Passcode and set a passcode to
prevent your kids changing settings you've applied to their Mac.

10
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New for macOS 10.15: Catalina ] New for Catalina

s Find My
Friends and Gadgets

For Catalina, the Find My Friends and Find My App are merged into a single
app, ‘Find My'. With it you can keep track of your friends’ whereabouts, and
also track down a missing Mac, iOS device, Apple Watch or AirPods. It's
great if you're arranging a meeting, or finding lost or stolen Apple gear.

The People Tab

The Find My app is divided into two sections, represented To start sharing vour location with friends or family members,

by tabs at the top of the sidebar; People and Devices. tap the share My Location link at the foot of the sidebar. You
Unsurprisingly, the People tab is for finding friends and family who should then enter the name, Apple 1D email, or phone number of
are sharing their locations. If it isn't already selected, tap it. the person with which you want to share locations.
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As is usual, you can tap the + sign to the right and select The people with whom you shared your location can now
a person from your Contacts app. Add as many people see exaclly where you are, that is the blue spot which
as you wish, and tap the Send link. Then you can choose you can see on the map. You can pinch and spread to zoom
whether to share for an hour, the rest of the day, or indefinitely. into and out of on this map, just like you can in the Maps app.
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To access this options window, tap on the name of someone

with whom you're shanng your location and click the 1" icon
on the tlab next to their photo on the map. From here, you can lap
Contact to bring up their card from your Contacts app.

vé Click on a friiend who isn't currently shanng their location
with you, click on the T icon and then tap Ask To Follow

Location to request they do so. If they comply, they also appear
on the map, along with yourself and others.

Returning the Favour.

[

Shara Your Locston

Share for D ilour

Shars: it ey

Do Shaary

When someone shares their location with you, it appears
in your sidebar and you're given a notification. You can
return the favour from either of these indicators, and
share your location with them.

|

Find My | @
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Other options available on this screen are: ask for their

location, stop sharing your own, or remove them from the
people with which you're sharing. You can also send them a
notification when you leave or arrive.

Something else you can do from the ' icon's pop-up

window is get directions to your friend’s location. Just click
the Directions option, and you're shown how 1o get there, Clicking
Contact opens their contact card.

The Me Option.

Tap Me at the top of the sidebar and click the I icon in
the tab showing where you are on the map. A pop-up
window identifies your location, which you can name
(work, home, school, and so on), and can also stop
sharing your location too.

wwwhbdmoublicalions com | 21




New for macOS 10.15: Catalina

The Devices Tab

The Devices tab, found at the top of the sidebar, gives 2 The sidebar on the left of the window shows your Apple gear.
access to what used to be called Find My Mac. Tap it, and If a device hasn't been online recently, it is listed as 'No
any Apple gear you own that's logged into the same Apple ID as location found'. Its location will be updated when it next goes online,
your Mac is shown on the map. so If it's been stolen, keep checking back.

lan Dabaine’s iPRaie

3 Tap a device on the map or list and then the ' next to its n Tapping the Directions option opens up the Maps app

map icon for an options screen. To locate a device that's and gives you directions from your current location to the
likely to be within earshot, tap the Play Sound link, Your device whereabouts of your missing device. As you can see, this one
makes a noise, enabling you to find it. isn't too far away; maybe it was dropped in the street?

Mark As Lost?
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If you fear a device is completely and irretrievably lost, as When you lock a device, you can enter a phone number
opposed to simply being mislaid in the house or at work, and a short message, which is displayed on the
you can tap Mark as Lost to lock and frack the device, This gadget’s lock screen. This way, an honest finder can see the

prevents thieves or finders getting at your precious personal data.  message and give you a ring to say they found it.
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7 To access this options window, tap on the name of someone The Find My app a draws its maps from the Maps app, so

with whom you're sharing your location and click the ' icon shares some of its functionality too. Like in Maps, you can
on the tlab next to their photo on the map. From here, you can lap tap the amrow icon in the bottom right to home in on your current
Contact to bring up their card from your Contacts app. location, or that of the person/device selected in the sidebar.
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Other options available on this screen are: ask for their Like in Maps, you can pinch and spread on the screen to

location, stop sharing your own, or remove them from the zoom into or out of the map. You can also click and hold
people with which you're sharing. You can also send them a with one finger, to drag the map around the screen and tap the
notification when you leave or arrive. 3D icon to switch between 2D and 3D viewing.
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As a last resort, you can tap the Erase this Device option 3 Tap the tabs at the foot of the map and you can switch
to wipe it clean of all information. This should only be between a drawn map, a satellite view and a hybrid, that
done if you've given up all hope of ever recovering it, as, when is, a satellite map with street names overlaid. Also, switch
it's wiped, it can no longer be tracked using the Find My app. between miles and kilometres in the View > Distance menu.
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New for Catalina

Sidecar:
With Your IPad

If you have a Mac running macOS Catalina and an iPad running iPadQOs,
you can use your tablet as a second screen for your Mac. This is especially
good news if you also use an Apple Pencil. You can draw on your iPad,
using it as a high-resolution input device for your Mac.

To use Sidecar on your Mac and iPad, first of all, open
System Preferences on your Mac then click on the
Sidecar preference pane. If it isn't there, your Mac's too old to
use Sidecar,

CLAND e RAR0ERO0Y - #57) S ¥

3 There’s a bnef flash, and your Apple devices connect,
sharing screen space between your Mac and your iPad.
Your iPad can now be used as an input device or second screen
when used alongside your macOS device.
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E You can set where the Sidecar Sidebar and Touch Bar
appears on your screen, If at all. When you're done,
look in the pull-down menu labelled 'Connect to', and choose
your iPad.
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To move your iPad to the other side of your Mac, open
System Preferences = Displays = Arrangement. Drag the
smaller blue shape arcund the larger one, until it's where you
want the iPad to reqgister.
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Using the iPad as an Input Device.

With Sidecar, you can also use your iPad as a graphics tablet. According to Apple, any Mac app that supports stylus input
works in this way, but the company has also come up with a preliminary list of apps that you can use with the Mac, iPad,
and Apple Pencil:

Adobe lllustrator CorelDRAW Motion Substance Designer
Affinity Designer DaVinci Resolve Painter Substance Painter
Affinity Photo Final Cut Pro Principle ZBrush

Cinema 4D Maya Sketch

System Requirements.

To use Sidecar, your Mac must meet the following requirements;

iMac 27-inch 2015 or later MacBook Pro 2016 or later

Mac mini 2018 or later MacBook Air 2018 or later
Mac Pro 2019 or later MacBook 2016 or later
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More Great Features
Of macOS Catalina

Catalina also brings with it a wealth of features and add-ons that help you
get even more from your Mac. Your Apple ID information is now in one
preference pane, you can approve passwords and app installations with
your Apple Watch and even control the Mac with your voice.

App Tiling.
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App Tiling is a new way of using your apps in split-screen Mow click on another app that can be viewed in
mode. Click and hold the green gumdrop for a menu that split-screen. It automatically tiles itself to the other side of
lets you go full screen, or tile a screenshot on the left- or the screen, giving you a split-screen perspective without
right-hand side of the desktop. Choose a tiling option. having to drag app windows on to the desktop bar.

Continuity Markup and Sketching

You can draw on a document,
or even make a drawing from
scratch, on your iPad or
IPhone and have the updates
appear in real-time on your
Mac. This is especially useful
if wou have an Apple Pencil.
Connect your Mac to your
iIPad using the new Sidecar
feature, and open a PDF (for
example). Then, using your
IPad as If it was a graphics
lablet that also shows what's
on your Mac's screen, you
can write on and annotate it
using your Apple pencil.
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Security Features
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1 The first ime an app needs to use one of your Mac’s tools,

such as the microphone or the webcam, it now has to ask
first. You're also asked if an app can use your Documents,
Desktop or Downloads folders, iCloud drive and more.

Approve with Apple Watch.

IO %R0 " aBBO T

If your Mac and Apple Watch meet the requirements, you
can double-click on your watch’s side button to open
locked notes, view passwords in Safari preferences, and
more. Your watch authenticates instead of your password.

More Great Features [
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The Mac's Gatekeeper feature has been enhanced. The first
time you open an app, Gatekeeper checks for known
secunty issues. If it's from an unidentified developer, you have to
give it permission to open through System Preferences.

You can approve app installations with your watch too, and
even modify root files. Again, when asked to do so, just
double-tap the side button on your Apple Watch and the
task is approved without resorting to passwords.

QuickTime Player Enhancements
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1 When playing a video in QuickTime Player, hover the pointer

over the video to reveal the control panel. Click the icon on
its nght-hand side to have the video appear in a floating window,
which is always on top of other windows.

Click CMD-I or use the Window pull-down menu to open the
Movie Inspector. This has been enhanced and now shows
more in-depth information about the open file, such as video colour
space, HDR format, aspect ratio and more.

et | 27




New for macOS 10.15: Catalina ]

Read-only System Volume
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The Music, TV, and Podcasts apps, which replace the old iTunes In macOS Catalina, the system runs on a dedicated system

app, all sync their content through 1Cloud. So, it you buy or rent volume, which is read-only. This keeps it separate from all your
media on one device, it's made available on all your Apple gear other data, and makes it impossible for you to accidentally
that’s signed into your Apple 1D. overwrite a critical system file.
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If you open System Preferences, and click on the Apple Connect a device, such as an iPhone or an iPad to your
|ID pane in the top right, you can access all your account Mac, and it appears in the Finder’s sidebar. Click on it and
information and settings in one place. Your options and you can update, restore, or back up the device, just like
Apple devices are found in the left-hand sidebar. you used to do with the now-defunct iTunes app.

Restore from Snapshot

n If you install a macOS update that breaks an essential app, After logging in with your administrator's account, choose to
you can restore your Mac from a snapshot taken just before Restore from Time Machine Backup, even if you don't use

the update was installed. First of all restart your Mac, and then, Time Machine. You can then restore from a local snapshot, taking
when you hear the tone, hold CMD-R to boot into Recovery Mode.  your Mac back to a point prior to the update.
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Voice Control
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1 With Catalina, you can control your Mac by simply B To open an application, say, "Open [name of app]. It
speaking to it. To get starled, go to System Preferences then opens, just as it would if you tapped its icon on the
= Accessibility, and click Voice Control in the sidebar. Tick the Home screen. To return to the Home screen, say "Go Home".
Enable Voice Control checkbox, and input your administrator's To return to the previous screen, say “Go Back”. To close an
password when asked. app, say "Quit [app].”
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Say “Show/hide grid” to make the grid appear and If you open a menu, as seen here, available options are
vanish, and then say a number from the grid to overlay a numbered as shown. All you need to do to activate one

smaller, more detailed grid there. When there’s only one button of these options is say, “Click [number]”. You can move the
or link in a square, say “Press [number]” to tap it. In Safari, you pointer around the screen by saying "Move cursor left/right/up/
can say “Scroll Up/Down” to navigate too. down [number] pixels” too.
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You can also dictate text using Voice Contral. If you To review available Voice Control commands, deactivate
make a mistake, say “"Carrect [word/phrase]” and it's ones you don't need, and even add new custom
highlighted. You're offered a list of corrections. Say the number  commands; in System Preferences, go to Accessibility = Voice
of one of these suggestions to insert it. You can replace words Control and click the Commands button at the foot of the

with emaojis this way too. window. There's a great range on offer.
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Starting Out with Your Mac and Catalina ]

Set Up Your Mac
For the First Time

Setting up your new desktop or notebook Mac for the first time can be a
daunting experience but it's nothing to be afraid of. In this section we take you
through the initial set up process, from switching it on and setting up or logging
In with your Apple ID, all the way to having it ready to use.
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Your first step is to choose your territary, that is, where
you live and will be using your Mac. You can scroll the
list of countries up and down to find your own. Click your
country to highlight your choice and then click the arrow
marked Continue.

3 MNow choose your Wi-Fi network. Scroll up and down the
list until yvou find your routers S3ID (service set identifier)
and click on it. Enter the password in the field provided and
move on. The router's SSID and its password should be
supplied with the router.
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Now select your language and input source. The
default ones for your chosen territory are offered, but if
you want to change them, click Customize Settings and set
the language your Mac uses and the keyboard layout to suit
yvour needs.
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n Next comes the Data & Privacy screen. You're shown an
icon that appears when an Apple feature collects
information, and needs your permission. There's nothing you
need to do on this screen, just read it for reference and move
on once maore.




ransfer Information to This Mac
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You're invited to transfer information from a Mac or Time
Machine backup, a Windows PC or not at all. To transfer
data from your old computer, choose the correct option and
follow the on screen instructions. Otherwise, choose the last
option to start afresh.

Sign In with Your Apple ID

Bhgh 8 10 ube Choied, T ADD S10NE, e olbee AOD0E Sreiled

@ @ Ccn®

PRl T 3 O O DO P B BV M A BN CH R TR (S

miacllS Serra o Wler. Plasses enler e ocode B oond e

e p— p— — —

If you already have an Apple device, a six-figure identifi-
cation number is sent, which you must type now. If it
doesn't arrive for any reason, click the link under the number
fields and follow the instructions. Otherwise, type the numbers
and proceed.

Create a Computer Account
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Your account name is based on your Apple |D name but
your password, which unlocks the computer, should be
chosen now. Choose something you can remember and enter
a hint in case you forget. We recommend you agree to both
the checkbox options.

Set Up Your Mac For the First Time

Sign In with Your Apple ID
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Now it's time to sign in with your Apple ID. If you already
have an Apple ID, sign in now with your password. If you
don't, click the Create New Apple ID link and follow the
on-screen instructions. There’s also a link for if you've forgotlen
your Apple 1D,

Terms and Conditions
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You're shown a screen of Terms and Conditions, which

you can read by clicking More under each entry if you
wish. When you're ready, click the right-pointing arrow at the
foot of the screen to agree. Then click the Agree button on the
poOp-up screen.

Express Set Up
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On the Express Setup screen, you can set up your Mac

quickly, by allowing predetermined settings to take
effect, for things like Siri and Maps. You can customise these
settings by clicking the link; we suggest you just click
Continue instead.
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Screen Time
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You now decide whether or not you want to set up

Screen Time. Click Continue to have Screen Time give
you updates on how you're using your Mac, or the Set Up
Later link at the top to leave it be for now. You can aclivate it
later in System Preferences.

FlleVault Disk Encryption

F o] SaEuses o Sl Dp & 0P 0 | Pel e At OF somol Degh, 3] W2 i wisal SCTOER mlh
o e Wil

Waould you bk 1o use FileMest 1o ercrppi ihe delk on your BacT

1B Tusrn on © il Vawl! diie smeryleen
1B Adioow ey b e evar® 1o urlsck my ik

R ol dald Pl TSN DTS B e D0 C08 Db slald T SMROE pa Orlh WPl 0] s’ plidard ] 0 plna
Ferpi £
B i i T B A 0l BODOAT 1 TR R AR, A O CTRE  FRCOET EEY
andilosr o b nabe phan birdinch pin dfish

A -
-\.{__. s

13 Choose whether to secure your disk with File Vault

Encryption. If you change your mind later, you can go
o System Preferences = Security & Privacy, and click on the
File Vault tab. You can change your File Vault preferences
from there.

Setting Up Your Mac..

MNow you wait for your Mac to finish setting up. Be patient.

It might well take a few minutes to sort itself out. The ticks
appear on your screen one by one, and eventually, the Catalina
desktop appears. Your setup is now complete.

All your files and photos in iCloud
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m If you accept the option to stare all your files in your
ICloud service, documents and data on your Mac’s
desktop and in your Documents folder are synced across all
the Apple devices logged into the same Apple ID. This is
convenient but takes up storage space.

Choose Your Look
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You now decide on how you want your Mac to look. You
can choose Light Mode, Dark Mode or have it swap
between them according to how high the sun is in the sky. This
decision is not permanent; you can change it in System
Preferences later.

F—
Bppen e F - H
Lighs Dl dar

uwrir: QBB 0 B 0
Fhghiag L colour B B

Selubar rcon swew: Wedurr H

e T 3l iy Ml B rad e 1he e Do

Svirw Bein Do MDN dsicmrasicaly asmd or mouma o ack s
Whan scrollisg
LRt

oy b e 5ol b v D) Jerrp Lo the nasl gage
Jorrp D Ui dasl il Shiad

Deladi wab boowas: @ Sl E

#ine b ke charges =an cloa ng doowmenis
Hl.'h.lu“nd-u'nlul'—'uu'.'!rql-nu
T Ll T i T A B el el BT B FE AT
T i R g A dg
Resgers namy: W . Dt umesrs, Appri g Severn

Bj Lae fzre armoaibing snen ook sha

If you change your mind about some of your chosen

options, you can change them in System Preferences. For
example, the Analytics option is in Security & Privacy = Privacy
and the Light ar Dark Appearance is found in the General pane.
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More Options You Might See Reset to Factory Conditions.

We've shown you the simplest way of setting up your Mac but If you acquired your Mac second hand, you might want
there are a few more options you might find. to wipe it clean and start again. Just follow this guide.

macOS Hildtles  Fie Hoit i BN [ e

macQs Utilities
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Belndtall el
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Disk WHily

First, restart your Mac whilst holding down CMD and R; keep

If you're using a MacBook Pro, there's an additional step them held until you see the Apple logo. A window appears,

to register a fingerprint with Touch ID. This is used for titled ‘macOS Utilities'. Select Disk Utility and click Continue.
unlocking your Mac and for making purchases with Apple Pay =elect your startup disk (called Macintosh HD by default) and
Follow the on-screen instructions to register for Touch 1D or click Erase.

click the link to set it up later,
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On the next screen, the Format pull-down menu should read
APFS if it's available or Mac OS5 Extended (Journaled) if it
isn’t. Select the appropriate option and click Erase to wipe
your boot drive. When it's finished, click Done, then quit Disk
Utility (CMD-Q).

E If you don't opt for the Express Setup, you have to set up
a few things separately, such as whether you Enable
Location Services and whether to share analytical data with
Apple and third-party developers. You can change your mind
later if you wish.

macOS Catalina

Tip BRY A 17w ergballation of macDE Conaral, chok Conkims.
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3 Siri is Apple’s digital personal assistant. The feature can Now choose Reinstall macOS and continue. When invited to
be enabled or disabled, depending on whether you install the operating system, do so; you might have to click
want to use it. If you use the Express Setup, Siri is turned on on the Wi-Fi icon in the menu bar and rejoin your wireless
but either way your choice can be changed in System network. Agree to T&Cs, select your main drive and click
Preferences later Install to start afresh.
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Update macOS
10.15: Catalina

| i

You can also use these tips

to upgrade to future macOS

releases, whenever they are
made available.

If your Mac is running an older version of the operating system, you're

probably keen to upgrade to the latest release of macOS, Catalina. Apple has
made this very easy to do. As long as your Mac meets the minimum system
requirements, you can upgrade over the Intemnet, and it's free.

Popular S1ones

Apps that kook graat in Dark Moda

First of all, open the App Store and find the Mojave

operating system. Do a search if it's not immediately
visible on the front page. Click on macOS Mojave to get to the
download page.

Minimum Requirements.

Before you start, you should make sure your Mac is
powerful and recent enough to run macOS 10.15: Catalina.

The system requirements for Catalina are almost identical to those
for its predecessor, Mojave. To upgrade to Catalina, your Mac must
have at least 2GB of memaory, be running OS X 10.8 Mountain Lion
or later, and have at least 12.5GB of free storage space: possibly up
to 18.5 GB if you're running an operating system earlier than El
Capitan. It must also be one of the following models. To check, go to
the Apple menu and select About This Mac.

iMac Late 2012 or newer
iMac Pro 2017 or newer
MacBook Early 2015 or newer
MacBook Pro Mid 2012 or newer
MacBook Air Mid 2012 or newer
Mac mini Late 2012 or newer
Mac Pro 2013 or newer

36 | wwwbdmpublications.com
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When you get to the Catalina download page, you can

read all about the new OS. When you're ready, click
on Download. It may take some time if you have a slow
Internet connection.

Make a Backup.

It's always a good idea to keep a backup of your important
files, so make sure yours is up to date. Here's how to do it

Upgrading the operating system is a big step, so as always, before
making any major change to your computer, its a good idea to make
a backup of your data. The upgrade is a very safe process and won't
damage your files by itself but there’s always the unexpected risk of
a drive failure or power cut during the installation process, which
could leave your Mac crippled. Better safe than sorry!
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3 When the installer is fully downloaded, it automatically MNext step is terms and conditions. You have to click on
launches with this screen. Click Continue if you're ready Agree to continue. If you don't have time to read them,
to install and if not, quit it and install |ater, there's a copy available in About This Mac after the installation.
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macOS Catalina
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Next choose the hard drive you want to install Catalina on. After entering your admin password, Catalina begins the first
It will probably be your Mac's own hard drive but you can stage of its inslallation. All you can do now is wail. Make
install it on an external drive if you wish. Click Install to continue. sure you don't turn off or unplug your Mac during the process.

ristall mac0S Catalina

macOS Catalina

Warsion 10,15

mECDS Cﬂ'lalina MacBook Pro (Retina, 13-inch, Early 2015}
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7 The new operating system downloads and installs on It takes a while but eventually your Mac reboots into
your Mac. When the installation is complete, your Mac Catalina. You're asked to choose a few options, which
closes down any open apps and restarts. can be changed later, and after that, the setup is complete.
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Launching Apps
‘ And Quitting Them

There are several ways of launching an app on your Mac. You can: use the
Launchpad, which is found in the Dock; you can open a Finder window and
navigate your way to the application you wish to use; or you can click on the
Spotlight feature and simply type its name.

Using Launchpad

JAARGALBRTORO 9 - NN ® =¢ BEEEMRY

To open the Launchpad, go to the Dock and click on it,
or place four fingers on your trackpad and bring them

If you have more than one page of apps, move between
them by swiping left and right with two fingers or hold

together. The screen darkens and your apps are shown as CMD and use the arrow keys. Click and hold on an app and
icons. To launch an app from this screen, click on it. To close an ‘X' appears in the top left corner, except for Apple's own
Launchpad, press Esc or click on the desktop. apps. Click the "X to delete an app.
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3 You can arrange your apps into folders on Launchpad Open and close folders by clicking on and off the folder

too, just like on an i0S Home screen. Just drag one app icon on the Launchpad screen. You can add new apps
onto another and a folder is created. You can click on the into the folder by simply dragging them onto the folder. You can
name if you wish to change it and to remove an app from that also drag apps around the Launchpad window to change the
folder, drag it off the grey folder area. order in which they're arranged.




Launching Apps | &

Using Spotlight
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To launch an app using the Spotlight feature, first click Begin to type the name of the app you want to launch and

on the magnifying glass found in the tap right corner of Spotlight tries to complete it for you. When you see the name of
the screen. A window saying ‘Spotlight Search’ pops up. If it's the app, press Enter and it launches. To close the Spotlight search
inconveniently located, you can drag it around the desktop and  window without launching anything, just click anywhere on the screen.
move it to wherever you like,

Using the Finder Using the Dock

R
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You can also launch an app using the Finder, Open a new You can launch an app from the Dock. If your Dock is hidden,

Finder window (or use one that's already open) and click on maove your painter to the foot of the screen to reveal it and click

Applications in the sidebar. All of your Mac's apps are on the app you wish to use. To find cut more about the Dock,

shown. Find the one you want to use and then double click and how to customise it with your favourile apps, see our

on it to launch. tutorial later in the book.

Quitting Apps.

iPhone 11 Pro

Pro cameras. Pro display. Pro peformance

Open apps are shown in the Dock. On the app's Dock icon, Alternatively, with the app to the fore in Finder, click on its
you can click using the right-hand side of a Magic Mouse or name in the top left corner and select Quit [app name] from
trackpad (right-click), hold the Control key and click the menu; or hold the Command key and press ‘Q’. Just
anywhere (CTRL-click) or click and hold, then click on Quit in make sure the app is open on your desktop or you might quit
the pop-up window. the wrong application.
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Get on the Internet
X With Wi-

FI or Ethernet

The Internet is likely one of the reasons you bought your Mac. When you're
online with your notebook or desktop Mac, you can surf the web, send and
receive emails, make Intemet telephone and video calls, buy apps and media
and more. Here’s a guide to getting online using the Mac’'s Wi-Fi connectivity.

Going Online with Your Mac
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Open Network Preferences..,

Ensure your Mac is within range of your wireless router.
Click on the Wi-Fi icon in the menu bar as shown, and

look at the list of available Wi-Fi networks. If Wi-Fi is currently
turned off, switch it on using this same icon.
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3 Make sure Remember this Network is ticked, so you don't

have to enter your Wi-FI password again. Your Mac logs on
to the network and the Wi-Fi icon shows it's made a connection.
If the icon is only partly darkened, your signal strength is weak,
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Show passsond
B Remember His rabwsork

Cancel

Find the name of your own Wi-Fi network. If you don't
know it, check your router’s instruction manual. Choose
that network, and if prompted, enter the password. This too
should be in the router manual or on the router.

Using Public
Wi-Fi.

Some high street locations
such as libraries, bars and
restaurants offer free Wi-Fi
to their customers. There
are many different ways you
can access public Wi-Fi.
Some locations may have
an unsecured connection,
some require you to ask for |
their Wi-Fi password, and

for others you have to register via their pop-up website;
just open Safari while in such a Wi-Fi zone and then

follow the on-screen instructions that appear when your
Mac connects to the network.




Configuring Your Wi-Fi
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Open System Preferences from the Apple menu in the
top left corner of the screen or from the Dock and click
on the Network preference pane. Press the Advanced button
and make sure the Wi-Fi tab is open, from the list across the
top of the window.

InEEEE

You can see a list of all the Wi-Fi networks your Mac
has connected to, in order of preference; where two
networks are available, the higher one is used. If you want to
change this order, simply drag and drop them.
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Going Online with Ethernet.

If you prefer the stability and speed offered by a
cabled, Ethernet connection, here's how to set this up.

To remove a network from this list, click on it and click
on the minus button below the list. On this window, you
can also make the Mac ask for admin authorisation for
network tasks, using the checkboxes at the bottom.

Once you've set up your router according to the instructions
supplied with the device, getting online using Ethernet is
relatively easy. First of all, you need a cable that looks like
this. There should be at least one supplied with your router.

\ - N ‘

1“ ~

Plug one end of the cable into your Mac and the other end
into one of the router's Ethernet ports: it doesn't matter which
one. If your Mac doesn't have an Ethernet port, you need an
adapter. You can get one online or from an Apple Store.

If your router isn't close
enough to your Mac to | ,
support a cabled
connection, consider
using Home Plug AV
instead. This uses your r J
household electrical |
wiring to send data.
Ask at your local M |
computer store about a
Home Plug AV starter
kit. There are many
different brands of
HomePlug AV devices
to choose from, and as
HomePlug AV is an
industry standard,
they're all compatible
with each other.
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Gesture Controls
» On Your Trackpad

Something we really like about the Mac is the way you can navigate using
gesture controls, just like you do on your phone. These gesture controls
can be performed on a Mac notebook’s trackpad or on the Apple Magic
Trackpad, which is available for desktop Macs.

One of the things that makes the Mac such a pleasure to use is its large and responsive MacBook multi-touch
trackpad or the desktop Mac’'s Magic Trackpad. You can use the trackpad in much the same way as you would use
the touchscreen of an iPhone or iPad: to quickly and easily access menus, sort through stacks of pictures or
documents, scroll through documents and to zoom in and out of displayed images. Once you get used to it, you'll find
that it's a very easy and intuitive way of controlling your Mac and that it can do far more than just scrolling.

.. S8 EEnaam
Secondary Clicking. E LTI TTTI-T-TTT
Some people like to use a two-button =.......-.--.'..-.-.=
mouse with their Mac, and this can be handy ...-—..-.-
for quick access to shortcut menus by —
secondary clicking or right-clicking. To set up
two-finger secondary clicking using the
trackpad, select Secondary Click in the Point & @
Click pane of Trackpad preferences. To set up
a one finger secondary click zone in the \ ]
bottom left or right corner of the trackpad or | p i
mouse, select Secondary Click in the Point & . .
Click pane of Trackpad preferences, and choose Smgle Click

an option from the pop-up menu. Unlike most other trackpads, the entire MacBook trackpad
works the same as the mouse button; and you can click
anywhere on the track pad to activate apps and select icons.
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Multi-touch Gestures. Tl oLl alalatalal ol 1T
The MacBook's advanced trackpad supports the --ﬂ..nn-“..--
Multi-touch gestures. They might seem a bit complicated at MR E RPN D EER M

first but once you get used to them and have had a bit of AN E D =

time to practise, they quickly become second nature. Before
long you’ll wonder how you ever managed without them.
The trick to using the trackpad properly is to practise using
more than one finger at once. Some gestures use two
fingers, whilst others use three. You need to apply light, firm
pressure and move your fingers smoothly and evenly, all at
the same time. Like we said, it takes a little practice but you s

quickly become proficient at it. To enable Multi-touch .
gestures, view instructional videos of the gestures and set Scroll Vertically

up various other trackpad options, choose Apple > System Place two fingers together on the trackpad, then move them up
Preferences and then click Trackpad. or down. This will scroll vertically up or down the document or

web page you're currently viewing,
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Zoom In and Out

Two-finger pinching lets you zoom in or out on PDFs, images,
photos, and other large visual documents or web pages. Place
twa fingers on the trackpad, then move them apart to zoom in,
or together to zoom out. The quicker you mave your fingers, the
more you'll zoom.

.II.T-I—I-
A

Access Mission Control

You can access the macOS Mission Contral at any time, even
if you've got a full-screen app open. Simply place three fingers
at the bottom of the trackpad and move them quickly upwards
and Mission Control appears.

x Y,

Force Click

The very latest Apple notebooks feature Force Touch
trackpads, which can tell a soft tap from a hard tap. A hard
tap, or Force Click, can be used to preview a file, drop a pin
in Maps, preview a Safari link, rename a file or folder and
more. It's a concept that should prove very familiar to those
who have used the latest iPhone models.

Gesture Controls 5
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Rotating Images

You can rotate images by placing two fingers on the trackpad
and then turning your hand so that your fingers both move in a
curve. It can be a little awkward on the wrist at first but you'll
soon get used to it. With practice, you wonder how you ever
did without it.

|

Switching Between Full-screen Apps

If you've got several apps open full screen at once, you can
quickly flip between them using a gesture. Place three fingers
on the trackpad and quickly slide them to the left or right. This
will scoot the current app aside, revealing the next in line.

B Hywlern Prelereaces 081 Yow Wedon  Heo

Force Click

and wariablg

Turn Off Force Click

If you dislike the Force Click gesture, and find it gets in the
way of your workflow, it's easy to turn it off. Open System
Preferences (under the Apple menu in the top left corner),
and go to the Trackpad pane. Under the first tab, Point &
Click, you see a checkbox labelled ‘Force Click and haptic
feedback’. Uncheck it to turn off this feature.
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The Mac’s Desktop
And How to Use it

The desktop is at the heart of your Mac. Everything you do takes place on
the desktop, including opening apps, interacting with files and folders and
using the Dock. Here we show you how to use your desktop, app and folder
windows, the top bar menu, menulets, Trash and other key desktop features.

Menulet: A Menulet is

simply a shortcut or link to
the application or file. That way you
don't have to navigate to it every
time It's needed.

Utilities: Easy access o

Bluetooth and Wi-Fi settings,
volume level, time and date
preferences, some login options and
a handy search utility.

Apple Menu: From the

Apple menu you can log out,
shut down, restart or put the
computer into sleep mode, get
comprehensive information on the
computer's hardware and software,
access the System and Dock
preferences, and open items you've
recently closed.

4 Desktop Wallpaper: Why
have a plain background
when you can spruce it up with your
favounte photo? If you're bored with
the same one day after day, set it to
change regularly. You can even use

your own photos as wallpaper.

Folder Icon: In macOSs,

folders work just like their real
world counterparts. You can use
them to store files, data and other
folders. You can call them anything
you like.

44 | wwwbdmpublications.com

Finder Window: The

Finder utility is the central
point for navigation and file
manipulation. Browse and navigate
applications, documents, external
drives and even access other
computers, as long as they're
connected to the same network
(cabled or wireless).

7 Dock: The Dock offers quick

and easy access to your
favourite applications, documents,
folders and even the trash can. It's
easily edited and customised to
make the maost of the way you wark.
Apps you currently have open are
always shown in the Dock.

Dock Folder: You can also

putl folders in the Dock, as
shown here. The folder can then be
accessed like a Dock app.

Open Application
Window: Application
windows come in all shapes, sizes

and designs. Your Mac's
applications can be launched from
the Launchpad, the Dock, from
Spotlight or using the Finder.

The Trash: To delete a file,

folder or application, drag it
into here, then right-click on it and
choose ‘Empty Trash’ from the menu.

Finder File Edit
About This Mac

View Go Window Helf

System Preferences...
App Store...

<
Recent Items
o Favourites
% i = S
Force Quit Finder OED $ —

D 22 Dropbox (Pers
Restart... :
Shut Down... @) AirDrop
E Movies
Lock Screen
@ Recents

Log QOut lan Osborne... A
Applications

1 Documents

] Desktop

o Downloads

[ Team BDM

| personal

iCloud

Work Documents
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[ The Mac's Desktop -
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Choose New Wallpaper

[ B ™ B § = 4 TOuB & Weas I3pm ;_aai_l'

To open the Desktop preferences window, click the
Apple menu, select System Preferences, and select the
Desklop & Screen Saver option. Select the genre of piclure
required from the left column.
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Click on the image you'd like to use for your wallpaper.
The desktop is updated immediately, so if you're happy
with the selection, just close the window. IT you are nol happy,
you can easily choose another,

3 If you change your mind about your choice of image

and want to go back to the desktop you were anginally
using, just find it among the wallpapers on offer, and click on it
to restore it again.
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The first three wallpapers are dynamic; changing in
brightness throughout the day. Location Services must
be on. You can change the dynamic desktop to an ordinary
pic using the pull-down menu.

Use an Image from Your Photos Library.

Open the desktop preferences: Apple menu > System
Preferences > Desktop & Screen Saver. Select the Photos
item in the directory list, click the small arrow icon to open it.
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Select one of the options within to display any images
found. Click on the required image to set it as your
desktop’s wallpaper, as you can see here.



How to Add Your Own Folder
to the Folders List

Click the Apple menu and select System Preferences.
In the System Preferences window, select the Deskiop
& Screen saver option.

Click the ‘“+" icon which is below the directory list on the
left of the window to display a Finder window. Navigate
to the required folder, select it and then press Choose.

Deeskiinip & Soneen Saees

ISR screcn Saver

cancle@shurnerstack 146506506

3 The required folder should now be visible in the Folders
section of the directory list. Select your favourite image
from the thumbnails, then close the window:

[ The Mac's Desktop | i

Automatically Change the
Desktop Wallpaper.

You can even have your Mac regularly change your
desktop image to something new. Try it, it's fun!

Display the desktop preferences: Apple menu > System
Preferences > Desktop & Screen Saver. Toggle the Change
Picture option to show a tick. This opens the choice menu
to the right.

The wallpaper can be set to change from every five
seconds to once a day. It can even be set to change when
you log in, or when waking the computer from sleep mode,
so you should be able to find something suitable.
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Once you've selected a time option, you can opt to display
the images randomly or simply work through sequentially
by checking or unchecking the Random Order option.
Close the window and enjoy your desktop slide show.
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Dark Mode
= And Night Shift

If your screen’s too bright, there's a couple of great desktop features that
help. Dark Mode inverts the Mac'’s colour scheme, making it much darker,
and Night Shift Mode changes the colour hue, reducing blue light that can
keep you awake if you use your Mac before going to bed.

Dark Mode Night Shift Mode
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From the Apple menu, open System Preferences. Click From the Apple menu, open System Preferences. Click

an the General pane in the top left corner of the window. on the Display pane and then on the Night Shift tab. From
At the top, under Appearance’, are the Light, Dark, and Auto here you can schedule Night Shift Mode to run from sunrise to
buttons. Dark and Light buttons swilch to those modes, and sunsel or during custom limes; or you can simply turn it on by
Auto lets you schedule the changes. checking the Manual box.
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With Dark Mode on, the colours are subdued in Finder, With Night Shift Mode enabled, the colour spectrum

windows, the Mac's built-in apps and more, Third-party shifts from blue to yvellow. If you use your Mac late at
apps can be updated to take advantage of Dark Mode too. If night, too much blue light can interfere with sleep patterns, so
you find it more comfortable to work on a dark screen, this is using Night Shift Mode when on your Mac close to bedtime

excellent news. can prevent this.




[ Dark Mode and Desktop Stacks - -

Desktop Stacks
For Organisation

If your Mac's desktop regularly gets cluttered with folders, file icons and other
such material that you're currently working on, there’s a solution at hand in
macOS. With a click of your mouse or trackpad, you can organise them into
acks, grouped according to their file type. Here’'s how to do it.

e e BT (o Window  Heia g ~h-EEEEST X B TR T n,L — 3

Your Mac's desktop often fills with files and folders you
know you need regularly but that can mean a very

From the View menu, select the Use Stacks option. Your
files are stacked on the right-hand side of your desktop,

cluttered workspace. To use Deskiop Stacks, first click on the according to their type. For example, images are stacked
deskiop to make sure Finder is active, then click on the View together, as are documents. To turn this off again go to View
menu in the top bar. and click Use Stacks.

Wigw Go  Wiedow  Helo ¥ (2] e i B Wad Jlpm 1 | Bl Go  vArdaw  Mek

To open a stack, click on it. The items contained in that You can choose how you group your stacks. In View, go to
stack are revealed, allowing you to access and open Group Stacks By and then pick an option. If you use
individual files. To close a stack again, click on the down-pointing finder tags (see later in this book) to identify files from the same
tnangle icon that replaced the stack when you clicked to open it project, for example, grouping by Tags keeps them together.
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The Mac’s Menus
A Key Mac Feature

Menus are an essential part of interacting with your Mac. Whether it's a pull-down
menu accessed by clicking on the top bar of your desktop or a contextual menu

found by right-clicking or CTRL-clicking on a file or folder, you need to know how
to use your menus if you are to get the most out of your Mac and Catalina.

The Apple Menu

‘B ¥ Finder File Edit
About This MacB

System Preferences...
App Store...

View Go Window Help

Applications NP
E smw "Affh"y Pmmﬂ I“ Fi der
2 Show "“Blu-ray Player Pro” in |

Recent Iltems

N3t

Force Quit Finder
Sleep

Restart... B
Shut Down...

Lock Screen

Log Out lan Osborne...
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The Apple menu is found
in the top left corner of
the desktop. To open it, click on
the Apple icon once, then
choose an option. It's always
there, whatever you're doing on
your Mac.

Choose About This Mac
for a window showing you
technical information about your
computer. Tabs at the top of this
window let you delve further,
looking at its Display, Storage
and more; and you can get a full
System Report by clicking a
button too.

3 The Syslem Preferences
option opens the Mac's

System Preferences, which we

discuss later in this book.

This option opens the App
Store. If updates are
available for your Mac or any of
its apps, this is noted here too.

Howver your pointer over
the Recent ltems option to
see the sub-menu showing
apps, documents and servers
you've recently used.

Click here for the Force
Quit window. This window
lists all currently open
applications and notes if any of
them are unresponsive, that is,
they've crashed. You can force a
crashed app to quit from here.




7 Click here to put your
Mac into Sleep Mode.
This saves energy and
password-protects your Mac
while you're away from your
keyboard.

Click here to restart
your Mac. This is useful
if you've installed new
software or your Mac isn't
behaving as it should.

Click to shut down
your Mac, that is,
switch it off.
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Lock screen brings up

your password screen.
You have to enter your
password to continue to use
yvour Mac. It's useful if you're
leaving your Mac for a while
and don’t want anyone
snooping on it.

Click here to log

yourself out but not
shut down your Mac. This is
only really useful if you have
mare than one user account
on your Mac. You can then log
out so another user can log in.
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[ The Mac’'s Menus

By howvering over the

Recent Iterms option,
you get this sub-menu. This
is a list of the applications
you've recently used. Click
on ane of them to open it. It's
a great way of going back to
a recently used application.

13 These are the

documents you've
recently used. If you need to
open one again, this menu is
a quick and easy way to do
s0 without having to go
through Finder.

14 Servers you've recently

accessed on your
wireless or Ethernet network
appear here, We've
accessed quite a few
servers here. To open one
again, simply click on it in
the menu. If you never use
external servers, you can
ignore this menu item.

15 Click here to

completely clear the
entire Recent ltems
sub-menu and start afresh
with a clean slate.
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Contextual Menu

Files and folders have a Contextual Menu that you can access
by rnight-clicking or CTEL-clicking on the item. This menu gives
you a range of options, including rename the file, move it to
trash, duplicate or copy it, share it using the macOS Share
options discussed later in the book and more. The Get Info
option brings up a useful information window.
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Application Menus

Each application has its own unique set of menus located next
lo the Apple menu. They will change when an application is
active and will revert back to the Finder menu when no apps
are active. Each is clearly labelled to make it easier. We'll add
specific details for application menus when we look into the
applications themselves later.

Right-clicking and CTRL-clicking.

Mac mice and trackpads only have one button, so how do you make a right-click? It's actually easier than you think.
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Your Magic Mouse or Trackpad doesn’t have two buttons,
but you can still secondary-click by holding the Control
(CTRL) key and clicking your mouse or trackpad. Alternatively,
enable right-clicking. Go to Apple menu = System Preferences
> Mouse/Trackpad, depending on which you're using.
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2 Click the checkbox for Secondary Click. There are also
a few other options here such as click weighting. With
Secondary Click activated, clicking on the right side of a
Magic Mouse or with two fingers on a Magic Trackpad is the
equivalent of right-clicking on a two button mouse.
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. Using the Finder
Files, Folders & Apps

As the Finder underpins everything you do in macOS, it pays to familiarise
yourself with its features and functions. Here we show you how to use a Finder
window, including a guide to its navigation controls, viewing options and also
how to customise the window and get to grips with its advanced features.

Components of the Finder

The Finder is an important part of your Mac's Catalina
operating system, so pay close attention to the guides
over the next few pages. Lessons learmed in this section
serve you well whatever you're doing on your Mac.

Window Control Options: Use the gumdrops to
close or minimise the window or open it in full-screen
mode. See the tutorial over the page for more details on how

to do this.
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Navigation Controls: The chevron buttons found
under the gumdrops in the top left corner of the window
take you forwards or back through your navigation history.

3 View Options: These four buttons let you set-up
how you view the files and folders in the Finder
window; whether as icons, a list, in columns or as a cover
flow which gives you a much larger visual preview,

Item Arrangement List: Click on the button
marked ‘Arrange’ to order the contents of the window;

according to date, alphabetically and mare.

L

WG D29 EPG

S
-
!

40 D29E.JPE I D298, JPE

IMNG_0E09, JPCG

IMIG 0302, PG

basel101658. .. erstock . |jpeg

Information
5 Qetober 2015 &1 09005
b Dotober 2015 at $E00S
Today, 14:40
4064w 1048
300= 300

IMG_ 305, PG5

MG _0215, IR0 G 03713, P0G

1 of 458 selected




Share Button: The Share button is found in many
places throughout macOS. Here you can highlight a file
or folder and click the button to send it by email, AirDrop etc.

Tags Button: You can tag a file or folder to make it
easier to spot, group it with other documents and folders
and more. An item can have more than one tag.

7 Search: If you're looking for a specific item, type its
name or contents into the Search field and press Enter.
You can then revise your search If it's still not found.

Displaying a Finder Window

There are several ways of opening a new Finder window
on your Mac's desktop. Let's take a look at each in tum.

Edit View Go
Mew Finder Window

MNew Folder
Mew Folder with Selection

Window Help

{+ 3N
~HN

Mew Smart Folder

Mew Tab ®T

Open #®0

Open With 13

Print #EP
®BW

Close Window

Using Menus

Click a clear space on the desktop once, open the File menu,
and select New Finder Window. A window then appears.

Shortcut Keys

Click a clear space on the desktop once to make sure you're in
Finder, then press the CMD and N together. A new Finder
window appears.

Using the Dock

If it isn't already displayed, move your mouse cursor to the
bottom of the screen to open the Dock. Click the Finder
Window to create a new window,

Window Controls Options.

The coloured buttons found in the top left corner are used to
resize or minimise the Finder window.

fn
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Close

Click once on the red button containing
a cross. This will work with the majority
of windows and applications.

Minimise

Click the orange button containing a *-'
sign. Again this will work with almost all
windows and apps.

Full Screen
Click the green button containing a '+
sign. Will full screen most windows.

Using the Finder E

Sidebar: There are various options on the Finder
window's sidebar. You can open specific folders like
Documents or Downloads, access external drives and more.

File/Folder View: This shows the files and folders
contained in the currently open folder. They're shown in
the format chosen in the View Options (see 3).

Preview: This is a preview of the currently selected file
in the main window. It shows the title, file size and various
details about it. There are options at the foot of the sidebar,

How to Relaunch Finder

If the Finder has crashed or isn't behaving as it should,
follow this tip to close it like a crashed app and relaunch it.

([} Finder File Edit View Go Window Help

Force Quit Finder S raEe

Restart...
Shut Down...

Lock Sm;
Log Out lan Osborne... %0

If the Finder crashes you can relaunch it like you would a
crashed app. The easiest way to do this is to click on the
desktop to make sure you're in Finder, hold down the Shift
key and click on the Apple menu. The Force Quit option has
become Force Quit Finder. Incidentally you can use this
method to quit any running app. Just click on one of its
windows to bring it to the fore, hold Shift and click on the
Apple menu,

Navigation Controls.

These simple controls allow you to retrace your
steps backwards and forwards.

' | Navigate to a
@ © Previous Page

Click the left hand arrow. To
continue stepping backwards,
repeat step one as many times
as necessary.

i Using the Forward Control
: If you've moved to a previous page,
this button offers step-by-step
navigation to your original starting
point. Simply click the right-hand
arrow as many times as needed.
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View Options
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View Window Contents as Icons

To display your files and folders as a collection of icons, first
open a Finder window then click the first button on the toolbar,
showing a group of six sguares.
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View Window Contents as Lists

With an open Finder window, click the second button on the
toolbar to use a simple but effective list display.
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View Window Contents as Columns

Click the third button on the toclbar to view your files as a
series of columns. It's great for quick navigation and easy
visual identification using a handy image preview column.
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View Window Contents as Gallery View

The Gallery View gives a large preview of the file or folder that's
currently selected and a scrollable strip of everything else. Click on
one of the files in the strip to see a larger version of its thumbnail.
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Change the Way Iltems
are Arranged.

As well as changing the way the items are visually displayed, you
can also change the way they are arranged within the file and folder
view area.

Name: Alphabetical. Displays numbers first, then A-Z.
Kind: This groups each type of item together.

Application: Groups together items according to the
application in which they were created or are opened.

Date Last Opened: Groups according to time and date
they were opened.

Date Added: Displays items in order of when they were
added to the folder.

Date Modified: Displays items in the order they were last
modified or edited.

Date Created: Displays the items according to when they
were created.

Size: Arrange the files according to their size.

Tags: Files are arranged according to tags you've added




More Sidebar Functions.

If your sidebar is getting cluttered, you can show or hide its
listed items by hovering over the title (Favourites, Devices,
Shared, Tags) and clicking the word Show/Hide that appears
as shown. You can also eject external drives, CDs and disk
images from the sidebar, by clicking the eject icon next to the
device or image you wish to remove.
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Click on the cog-shaped icon for a drop-down menu.

Here you can do a range of operations, from opening a
file in a specific application to checking the file size via the Get
Info option.

The Finder’s Preview Panel.
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Finder windows have a right-hand sidebar that shows a preview
of the currently selected file from the window. You can turn this
sidebar on and off in the View menu (Hide/Show Preview).
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You can also clean up the entire Finder Window,
automatically tidying up and or reorganising the order of

the files according to various criteria such as their name
(alphabetical), date, size and more.
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At the foot of the preview sidebar are new options. These vary
according to the type of file you're highlighting in the main

window. For example, an image can be rotated, annotated or
turned into a PDF.
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Full-screen Mode
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You can view a Finder window, and indeed, an
application window, in full-screen mode. Click on the
green Enlarge button in the upper left corner of the window
and it will expand to fill the entire screen. Alternatively, use the
View pull-down menu or press CTRL-CMD-F
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3 To exit from full-screen mode back 1o the usual window
view, bring up the Menu bar and then simply click on the
green button again. The window shrinks to its previous size
and no longer lakes up the entire desktop.

32-Bit Apps No Longer Run.
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In full-screen mode, the menus usually found at the

top of the Mac desktop are still there, but they're
hidden away until you need them. To see them, move the
mouse cursor to the top of the screen and the menu bar
slides into view.

You can also take a window out of full screen mode
using the View pull-down menu at the top of the screen
or by pressing CTRL-CMD-F. You can still close a full-screen
window with the red button (top left).

Apple has phased out support for applications built for 32-bit architecture. These will no longer run in macOS.

i

In macOS Catalina, you can no longer open applications made
for older 32-bit processors (modern processors are 64-bit). If you
have such an app on your Mac, it appears in the Applications
window, or Launchpad, with a crossed-out icon atop it.
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Try to open a 32-bit app and you get a message saying it's
not compatible with this version of macOS. Check with its
developer whether the app has since been updated to 64-bit,
but if it hasn't by now, it might well have been abandoned.



Changing the Finder Window’s
Background Colour or Image
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When you're using the Finder's Icon View, you can

replace the white background with a black one or even a
picture. To begin, with the Finder window in question open,
select Show View Options from the View menu or press CMD-J.
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The window's Info window opens. Towards the bottom, you
can see oplions listed under the header 'Background'.
Select *Colour’ and click on the white square. You can now use
the various options to change the background colour.

[ Using the Finder &

Accessing iCloud Drive.

iCloud Drive can store and share files across Mac or i0OS
devices logged into the same iCloud account.

Click on iCloud Drive in the Finder window's sidebar. You
see the iCloud Drive folder is organised according to apps.
You can create your own folders here too.
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Files and folders found here are synced using iCloud Drive,

so they're available online at www.icloud.com and also on
other devices linked to the same iCloud account.

Select ‘Picture’ and then drag an image into the box to

the right of the background options to get a pictorial
background. Alternatively, click on the box and then navigate to
the picture you want to use through the Finder.

Here we've opened the Pages iOS app on an iPad. As you
can see, the documents in the Mac’s Pages iCloud Drive
folder are also available to open and edit here.
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The Mac’s Dock
e For Most-used Apps

The Dock is a great way of gaining quick and easy access to all of your most
used applications, documents and folders. It is completely customisable, so over
time, you can adapt it to best fit your needs. You can keep it on the screen at all
times or have it hidden until you need it too. Here’s how to customise and use it.

Accessing Your Applications from the Dock

Launchpad

Add or Remove an Application

To add an app, first click the spaceship icon at the left-hand
side of the Dock to bring up Launchpad, then click and drag
the item you want onto the Dock. To remowve it, just drag it out.

ueﬂﬁﬁi - [l @ AWK

Open an Application

To open an application that's in your Dock, simply drag the
mouse pointer onto the Dock and click on its icon. Notice that
the app icon slightly bounces as the application opens before
the main app opens.

58 | wwwibdmpublications.com

Move an Application

To move an item to a new location in the Dock, click and drag
to the required position. As you mowve the item the adjacent
applications will move aside to indicate the final position.

Recently Used Applications

In Catalina, applications you've recently used are shown in the
right-hand side of the Dock, from where they can be used like
any other Dock app. Apps that are permanently in the Dock
aren't shown here.




Adding and Removing Stacks

You can add, remove and move folders in your Dock, in the
same way you do with apps. These sit to the right of the
Dock's second divider and are called Stacks,
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Accessing Stacks

To access the files and folders within a Stack, click on it to
display the contents. Clicking on a document or image opens it
with an appropriate application, and clicking on a folder cpens
it in Finder,

Viewing Options

Right-click or CTRL-click on a Stack for a pop-up menu with a

range of options. You can show your files as a Stack (a pile of

files) or as a folder. You can also choose how they're displayed
when you click the Stack.

The Mac’s Dock !

The Bin.

The Bin icon is located at the far right of the Dock and
can be filled and emptied just like a real rubbish bin.

You can delete a file, folder or app by dragging it into the Bin
on the right-hand side of the Dock. Alternatively. right-click or
Ctrl-click on it, and select Move to Bin from the contextual
menu that appears.
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To retrieve a file from Bin, click on the Bin icon in the Dock to
open it in Finder, then drag the file out of the Bin window. To
empty Bin, right-click on it and choose 'Empty Bin', or in the
Bin window, click on the Empty button (top right).

Customising the Dock.

You can customise your Dock in System Preferences from
the Apple menu and selecting Dock. From here, you can
place the Dock on the right, left or bottom of the screen,
opt to show and hide it, change its size, change its
magnification, choose a minimisation effect and more.
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® Notification Centre
See What's Going On

The Notification Centre gathers together all your important updates, notifications
and everything else you need to know, all in one place. You can configure it to
suit your needs, and it also provides on-screen reminders and alerts so you'll
never miss a thing. Here's how to access and use it in macOS Catalina.

Accessing Notification Centre Responding to Notifications
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Click the icon showing three horizontal lines preceded Clicking on any notification in Notification Centre takes

by bullet points, which is found on the far right-hand side 1 you to its app. For example, if the notification is a new
of the Apple menu bar at the top of the screen. Click on the message, you're taken to Messages where you can type your
Motifications tab at the top to see your notifications. response. To close a notification, click the cross.
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DO NOT DISTURB
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Alternatively, use a two fingered right-to-left swipe on a B To turn off all on-screen alerts, go to the Notifications panel,
trackpad. This works with a Magic Trackpad (shown scroll down to the Do Not Disturb switch to mute notifications
here) or a Mac notebook’s built-in trackpad, but you must for the rest of the day. Alternatively hold Alt and click on the
swipe at the extreme rght side of the trackpad. Matifications icon in the menu bar When muted this icon is greyed.




Notification Centre Settings
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To open the Notification Centre Settings pane, either
open the Apple menu and select System Preferences or
click on Systemn Preferences in the Dock. You can also find the
Motifications preferences via the icon in the top right corner,
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3 In the MNotifications Settings pane you'll see a list of your

apps. You can select which ones you want to appear in
MNotification Center here, Click on an app to show its options in
the panel on the right-hand side, as shown.
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All notifications appear in the Notification Centre sidebar
pane regardless of the option you choose here. You can
select different Alert Style settings for different apps, so some
are shown as banners, some as alerts and some not at all.
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2 Alternatively, open the Natification Centre as explained
on the previous page and click on the cog icon in the
bottom right corner of the Notifications panel. The preference
pane for Notification Centre is opened straight away:.
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For Alert Style, select Banners and they appear briefly
on-screen and disappear. For Alerts the notification

remains on the screen until it's actioned or manually dismissed.
Mone turns off the app’s notifications.
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Racants by App

Using the pull-down menu, you can change the order in

which Notification Centre displays its notifications. Order
them manually by app and then you can drag the apps in the
left-hand window into a preferred order.
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Q,

The Spotlight Feature
Search Your Mac

Spotlight Search is Apple’s unique and ultra-powerful search system that
can find almost anything on your Mac. There's a whole raft of great features,
making it a really powerful and useful tool that's integrated into the apps that
you use every day. Here’s how to get the most from the Spotlight feature.

Using Spotlight’s Features
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To start using Spotlight, press CMD and the space bar,
or click the magnifying glass in the top menu, and the
Spotlight Search window appears. In Catalina, unlike older
versions of Spotlight, you can drag this window to wherever
you want on the screen; it's not fixed in position.

Start typing your search query into Spotlight and
immediately answers appear, with suggestions based on
the contents of your computer as well as other sources. This
may mean you only have to type a few letters of your search
term to find what you're looking for,

3 Spotlight can do instant unit conversions for you. For

example, if you want to convert from imperial to metric
weights (or vice versa) you just type in the number and a type
of unit, such as kilograms or pounds and Spotlight instantly
converts into other commonly used units.

It works in a similar way with distances and lengths,
which Spatlight can instantly convert into other units. For
example, if you type a distance in miles it instantly shows what
it is In kilometres, metres, yards, feet and inches. You can even
corvert parsecs into light years.




The Spotlight Feature @

Spotlight can do some currency conversions. Type in a For more conventional searches, Spotlight pulls its
number and currency unit, such as dollars or pounds, information from a wide range of sources, such as
and Spotlight gives you the equivalent value in a range of Wikipedia and documents it finds on your Mac. Search results
currencies at the current market value. are listed by category down the left side of the search window:.
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If you're looking for local businesses or sites of You can find people with Spotlight too. Start typing the
interest, simply type the name into Spotlight and you'll name of someone you know, and Spotlight quickly finds
quickly find what you're looking for, complete with a link to that person in your Contacts list and displays their contact
the Maps app and the option of travel directions from your details in the results window. Things like chat threads,
current location. Facebook comments and emails are also listed.
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Spotlight is also closely integrated into the core macOS Spotlight can find music by searching through your iTunes
apps, such as Photos. Start typing in your search term, collection to find albums, tracks and artists. Type a band
like the title of a particular image or photo allbum in your Photos name, a track name or even the name of a band member,
app, and Spotlight quickly locates it and takes you straight to it. Recordings with that name or by that band or person are shown.
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Setting Up Email

With email, you can send mails and attachments anywhere in the world, at the
push of a button. It's there instantly too. Here we take a look at what email is,
how you can get yourself an email address and how you can use your email
accounts on your Mac, with Apple’s bundled email client, the Mail app.

Setting Up Your iCloud Email
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If you set up your Apple 1D during your Mac's initial
setup, or if you signed in with an existing Apple 1D, your
iCloud email account is already in place. But if not, or if you
want to add another iCloud email account to your Mail client,
follow these instructions.
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3 MNow enter your Apple ID. This is the Apple 1D and
password you probably chose when you initially set up
your Mac., When you have confirmed your details you can then
click on the Sign In button to take you to the next step.
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Open the Mail application from the Dock and then under
the Mail drop-down menu found in the left of the menu
bar, click on the Add Account... link. From the pop-up menu
that appears, select the iCloud link and then click on the
Continue button,
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On the next screen, click on Add Account and your
iCloud account is added to the Mail app, for you to use
on your Mac. Your iCloud email can be your sole email account
or you can use it in Mail or alongside athers if you wish.
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To configure your Mac to access your email account from
your Internet service provider, you need your email
address, your password to access your email account, and POP
or IMAP (incoming) and SMTP (outgoing) server addresses.

macOS Catalina includes a sophisticated email program,
simply called Mail. You can find it on the Dock, as it's

there by default. The Mail App's icon looks like a postage stamp

showing an eagle. Click on this icon to open the Mail app.
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When you first open Mail you're prompted to set up your
first email account. If you've previously used Mail or set
up another account, you can add further new accounts by
going to the File menu and selecting Add Account,

You're now asked to enter your full name (this appears in

your own, and other people’s, contact lists), your email
address and your password (both supplied by your email
service provider). Make sure you type them in correctly.
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You're asked for the incoming mail server address. You

should have been given an address when you signed up
for your account. Type it in the box marked Incoming Mail
server, You can add a description if you want and when you
have it all correct, click on Continue.

You're asked for the SMTP or outgoing mail server
address. Type it where it says Outgoing Mail Server.
Check the Use Only This Server box and if your email service
requires it, also check the Use Authentication box. Type in your
username and password, then click Continue.
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_ Getting Started
Y with macOS
#  Catalina’s Apps

Catalina comes with a wealth of software
applications, or apps for short. We show
you how to use both their basic functions
and their more advanced capabillities, along
with, of course, the new features introduced
with macOS Catalina. Look out for the

< , Safari web browser, Mail email client,
News, Photos and more.

Learn more >
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Safari App
Your Web Browser

Safari is your gateway to the Internet, so it's important that you familiarise
yourself with the browser’s interface before you begin your online adventure.

n Navigation Controls:
These two arrow control
buttons enable you to move back
and forth between current and
previously viewed web pages.

Toolbar Buttons: These

buttons give you access to
various Safari features. You can add
or remove buttons by right-clicking or
CTRL-clicking on the toolbar and
selecting Customize Toolbar, See the
section on Customising the Sierra
Finder for more information.

URL Bar: Enter the website

address of your choice or a
search term that you wish to look up
into this bar, then tap the Return key.

n Reload Page: Sometimes,
if a web page fails to load
properly, you can fix the problem by
clicking on this button and reloading
the page.

Share Button: Click on this
button to see your options for
sharing the page you're viewing

using email or social media networks,

including adding the page to your
reading list.

Show Open Pages: Click

on this button to view all web
pages you currently have open in the
Safari browser, on both your Mac and
other devices signed into your ICloud.

7 Safari Tabs: When you're
browsing the Internet and you
want to have several pages open at
once, you can view each of them in
their own separate tabs.
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Add a New Tab: Clicking

this button will open a new
blank tab, which is then accessible
by clicking on the tab and entering a
search parameter or a URL web
address in the URL bar.

Sidebar: This optional display

area is opened and closed by
clicking on the sidebar button in the
toolbar, next to the Navigation Controls.
It's updated in real-time.

10 Bookmarks: Click on this
button in the sidebar to see
your bookmarks list, with your
favourite web pages and sites, which
can be visited by clicking the link.

Reading List: From here

you can view all the pages you
have added while browsing, using
the Add to the Reading List button,

12 Edit Bookmarks:

Previous versions of Safari
had an Edit button on the left panel.
This has now been removed but you
can slill go to the Bookmarks menu
and select Edit Bookmarks.

13 Main Window: This is

where the web page you're
viewing is displayed. You can scroll
up and down by using the scroll
function on your mouse.

14 Links: Click on a web link to
be taken to another page. Web
links can be text, which is usually
underlined, or a picture as seen here,
When you've moved to a new page,
you can return using the Back button
(see entry “1', on Navigation Controls).
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Open Tabs.

Start to type the address of a website that's already openin a
different tab, and Safan offers that open tab as a suggestion.
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Full Screen.

Browse in full-screen
mode by clicking on the
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Full Screen in the View
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Set New Home Page

Display Status Bar

File Edit View History Bookmarks Develop Window Help
About Safari
Safari Extansions...
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13 b cirrpL B st ko Pesc 2oim

Dlack Dog WMeda - Tech Gy

Master You

Settings for This Webasite...
Clear History.,
Services 3

Hide Safari #H
Hide Others WHEH

. Dog Media
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Quit Satari ®o

Open a new Safari window and navigate to the web page
that you wanl Safari o load each time you launch the
app. Click the Safari menu (top left corner), then select
Preferences to display Safar’s preferences dialog box.
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Ensure the General tab is selected and press the Set to

Current Page button. A small window may pop up
requiring confirmation; press Change Homepage to continue.
The required page address now appears in the text box above.
It's now your default home page.

Using Links.
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n Ensure a Safar window is open and active, i.e. the
window controls in the top left are the usual colours, and
not coloured grey. Click the View menu and select the Show
status Bar option, which is found near the top of the menu.

O Tips for Taking Better Photos

Many of these tips cover shooting technigues, others may sin
be advice about equipment and understanding a little more
Open "hitps:/edmpublications.com/clean-images-healing -brush/™ in a new tab

You should now see a grey strip along the lower part of
the window. If you hover the mouse over a link, the
status bar tells you exactly where the link is headed. This is
very useful if you suspect the link takes you somewhere you
don't want to go.

You navigate the worldwide web in Safari by using hyperlinks or simply ‘links’. Clicking on one takes you to a new page.
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It's time to upgrade!

A link in Safari can be a piece of underlined text, a picture or a
button, or simply an area of the screen. Drag your mouse pointer
across Safari. When it's over a link, the pointer furns into a hand.
Click there to open the linked page in your browser.
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Open Link in New Tab v d
Open Link in New Window

Download Linked File
Download Linked File As...

Add Link to Bookmarks...

- Add Link to Reading List -
Copy Link
) o C
Share p IS
- Y Services > r 4

If you don't want to navigate away from the page that you're
currently on, right-click or Ctri-click on the link and from the pop-up
menu, choose Open in New Tab or Open in New Window. You
can then look at the new page without closing the old one.




Display Tab Bar

[ Safari | @

I

Add Tools to the Toolbar
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To toggle Safari's handy Tab bar on and off, open a Safari
window and click View in the menu bar at the top of the
screen. Select the Show Tab Bar option. Alternatively, you can
use the keyboard shortcut: simply press CMD-Shift-T.
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-packed Apple guides!
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irching online for the answers you need; just reach in to your

Your current page should now have a tab marker just

below the bookmarks bar, as shown in the screen
above. To add a new tab, click the "+’ sign at the right of the
Tab Bar. If you want to hide the Tab Bar again, simply repeat
step 1 and it will disappear.

ari  File Edit BWYETE History Bookmarks Develop Window Help

v Always Show Toolbar in Full Screen
Customise Toolbar...

Show Favourites Bar
Hide Tab Bar
Show Status Bar

Show Sidebar
Show Bookmarks Sidebar
Show Reading List Sidebar

Show Reader
Show Tab Qverview
Show Downloads Y

Right-click or CMD-click on the toolbar and select Customise
Toolbar; or click the View menu and select the option from
there. A window slides down. To add a button to the toolbar, simply
drag it from the selection in the window onto the Toolbar,
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Repeat this with as many tools as you need. When you're
finished, click Done. To remove a tool from the toolbar,
hold the CMD key and drag it off; it disappears in a puff of
smoke. To reset the tools to how they were originally, drag the
default set of tools onto the Toolbar.

Tailor Site Settings and Block Auto-play Videos.

If you want to customise your Safari window's Toolbar, there are a variety of useful tools that can be added.

Clear History...

Services

 Hide Safari
Hide Others
Show All

You can tailor specific settings like the zoom level, location
services, content blockers and more for individual websites. These
settings are then applied whenever you load that site. Open the
website and in the Safari menu, select Settings for This Website.
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Page Zoom and Auto-Play are set with pull-down menus that appear
when you hover over their current values. By default, the Auto-Play
function stops videos with sound automatically playing when you
open a site but you can override this using the Auto-Play menu.
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Safari’s Top Sites.

Top Sites gives you a window full of useful shortcuts to
your most frequently visited sites. Here's how it works.
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Click on the URL field at the top of the browser to access a
window showing a grid view of website thumbnails you've marked
as favourites, along with those you've visited most recently.
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To add a site, click the URL field to open the Top Sites
window and then drag the URL into it. You can drag icons
around the Top Sites window to reorder them, or out of the
window to remove them.
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To the Top Sites window, macOS Catalina adds: Siri
suggestions, sites from your Reading List, bookmarks, tabs
that are open on other Apple devices signed into the same
Apple account as your Mac and more.

Pinned Sites
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1 If you're not currently in Tab view, go to the View menu
and select the Show Tab Bar option near the top of the
menu. Now open the site you intend o pin and right or
CTRL-click on its tab. From the pop-up menu, select the Pin
Tab option.
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Obsession

The site gets a small tab in the left-hand side of the tabs
bar. This is always in place, ready for you to click on it

and open the site. You can pin multiple sites in this way. They

all appear as small tabs, showing a symbol or letter indicating
their content.

Unpin Tab

m BDM Puk

Innovate, Edu

To remove a site's pinned tab, right-click or CTRL-click

on it and from the pop-up menu, select Unpin Tab. The
previously pinned tab then becomes a regular tab. You can
reorder your pinned tabs by dragging them within the tabs bar.
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To save a page for later, click the Share button and select
Add to Reading List. To view your Reading List, open the
sidebar and click the middle button (the spectacles). You see
the title, a thumbnail, and a brief summary of the page that
you saved. To revisit any of the pages in your list, click on the
list entry to go straight to it.

#

You can search your reading list by typing in the search

bar at the top of the list, and view only unread links by
clicking on the Unread button. To remove a site from your
reading list, right-click or CTRL-click on the site you want to
delete and from the contextual menu that appears, select
Remaove Item.

Stop Online Tracking.

Some Web advertisers track your online behaviour. To
protect your privacy, Safari can block this. In the Safari
menu, open System Preferences, click on the Privacy
tab and tick ‘Prevent cross-site tracking'.
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Websites that play audio as soon as you open the page
are really annoying. Thankfully, individual tabs can be
silenced using this simple Safari tip. In Safari you can tell which
one is making the sound. Just look for the tab with the speaker
icon, shown on its night.
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You can mute this sound by simply clicking on the
speaker icon. If more than one tab is producing audio,
right-click on it for more options. You can see which tabs are
making a sound, mute that particular tab or mute all the others.
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3 If the audio is coming from a video, you can enter picture-
in-picture mode from the Audio icon; right-click on it and
select the option. This puts the video in a floating window, which
you can watch while doing other things on your Mac.
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Using Bookmarks.

If you find a site that you like and would like to keep
coming back to it, you can add a Safar bookmark.
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Add a bookmark for a site by clicking on the Sharing icon and
selecting Add Bookmark. You can also use the Add
Bookmark option from the Bookmarks pull-down menu or
press CMD-D.
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You can access your bookmarks by using the Bookmarks
pull-down menu. Click on one of the listed sites to open it in
the current window. Bookmarks can be arranged into
folders, thus grouping similar sites.
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Bookmarks

Click on Bookmarks and select Edit Bookmarks. From here,
you can edit the names of bookmarks by right-clicking, arrange
them into folders (see the New Folder button) and delete them
by dragging into Trash.
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Getting More from Safari
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Show All Tabs

The Show All Tabs view, available via the View menu, lets you view
thumbnails of all the tabs you have open. Click one to open it, and
click '+ for a new one. At the foot of the window, you'll see tabs
open on other devices logged in with the same Apple 1D.

" & Safarl W00 Edii  View History Bookmarks Develop Window  Help i £ v x

Export Bookmarks...

Print...

+ MyList

Private Browsing

Private Browsing lets you browse the Internet without adding
tracking cookies or recording where you've been in your history,
Activate Privacy Mode by selecting New Private Window in the
File menu. In a private window, the URL field is darkened.
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your ICioud account

Clear  all history |

Cancel Claar History
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Clear Browsing History

In the History menu, the bottom option clears your browsing
history and website data. Hold Alt while you select it to delete
your browsing history, but not website data. To clear more
selectively, select Clear History in the Safari menu and use the
pull-down menu.




Bookmarks
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Charus Authentication

This password may be easily guessed and
should be changed to a strong password.

Safari can create a strong password for you, Waould
wou like ta change your passwond tar

“facebook.com"?
Change Password

Create Mew Ac

Mot Mowr
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Weak Password Warning

If you attempt to log on to a website using a passwaord that's
weak or easily guessed, Safari gives you a warning and
suggests you change it. Click Change Password and Safari
suggests a stronger one, which is stored in your keychain.
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Integrated Spotlight Search

Spotlight search is a closely integrated feature of macOS,
including Safari. From the search bar you can find links to web
pages, bookmarks, browsing history and documents on your
hard drive, simply by typing a search term.

The Reader View.
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B Enable Quick Website Search  Manage Websites._.
B Preload Top Hit in the background
B Show Favourites

Change Your Search Engine

To change the search engine Safari uses by default, select
Preferences from the Safari menu. Click on the Search tab and
from the pull-down select the search engine you want to use.
The sites on offer are Google, Yahoo, Bing and DuckDuckGo.

Smart Search Field
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Safari Extensions

You can add extensions to Safari to expand its functionality.
Open Safari’s Preferences window (Safari > Preferences) and
select Extensions. Click on the Get Extensions button to
access a web page, from where they can be installed.

Safari's Reader View cuts down on the distractions and lets you concentrate on what it is you're trying to read.
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The Reader View isn't available on every web page. Look for
these lines that appear in the left-hand side of the URL field
when you hover the pointer over it. If they're there, you can
click them to access the Reader View, for a simpler (and easily
printed) page.
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Wpple fcompany)” redirects here. For other companies of similar name, see
Apple (aisambiguation) § Brands and enterprises,
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The Reader View can be configured to your own requirements.
Right or Ctrlclick on the Reader View icon and you get a menu
as shown, from where you can opt to always use Reader View
on the current site. You can also click the two As icon to change
the font, size and more.




Getting Started with macOS Catalina’s Apps

b\ O

Mail App
* Send & Receive Emall

Catalina has a great bundled email application, so sending and receiving
emails is as easy as typing a message and clicking a button. Here’'s how to

get the most from the Mail app.

1 This button downloads new emails.
You can set your Mail app to check
automatically but this button does so manually

B When you want to write a new email
from scratch, click on this button to
open a blank one.

This button archives the selected
message. Very useful if you want to
make sure you don't delete it

4 If vou want to throw away the currently
selected email, click here to send it to
the Trash folder.

This button moves the selected email to

vour junk mail folder, Use it to help the
Mail app identify 'spam’, which is junk emails.

These three buttons let you reply to the

selected email, reply to everyone who
received the selected email and forward the
selected email to a third party.

7 This pull-down menu lets you mark the
current email with a flag, which is
useful if you want to group mailings
according to criteria of your choice.

B Use this button to silence notifications
on threads that are sending you too
many alerts.

This pull-down menu is another way of
moving an email into another mailbox
or folder.

To search for a specific subject,

person or word/phrase in your emails,
use the field here.
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This icon opens and These are email This is your email
closes the sidebar inboxes and as you accounts’ Sent folder.
shown here. can see, we have four email Click on it to see emails you've
accounts set up in Mail; sent. Open them and you can
m These dropdown however, you can have more forward or resend them.
menus let you navigate  or less if you prefer.
between mailboxes and can 17 Junk emails, or spam,
be used instead of clicking When you identify a are sent to this folder
on the sidebar. sender as a VIE their You can send them there
name appears in this section. yourself too (see '5').
Click this circular icon Click the triangle to open and
to toggle between close it, and click on a name Erails you've thrown
showing all emails and only in the list to see emails from away are sent to the
urnread emails. that person. Bin. You can take them out

& 7 o
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ils (36,584 messages, 5 unread)

F Move to... ’—B (] m
|

lan Osborne ~ -

Essential AppleUser Magazine w-r'

Have you seen this? It's the new issue of Essential AppleUser Magazine!

The Baron E

hone * MacBooks * iPad * Mac * iPod touch * &Watch * & TV |

ESSENTIAL =~ @eow
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Mail @ &

again, or empty the Bin, just
like the macOS Dock’s Bin.

19 Smart mailboxes let

you set up rules, so
emails that meet the
conditions applied appear in
a smart folder as well as in
the main inbox.

When Mail is

downloading new
emails, this message
appears, showing you how
many are being downloaded.

21 Your emails appear

here. Unread emails are
shown with a blue dot to the
left. Click on an email to open
it in the main window ("22").

E This is the main
window, showing the
currently selected email.

Emails can contain text,
images, links and maore.

If the email's sender is

in your Contacts and
has a picture, it appears
here. If not, it's just a grey
circle with an initial in it,

Updated
Classic
Layout.

To use the classic,
column-based layout, in the
View menu, select Use Column
Layout. You can also check or
uncheck Show Side Preview, to
set the email preview to the
side or below the list.
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Sending a New Email
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[T] Mailboxes \, Inbox ~ VIPs~ Sentw Drafts v Flagged +

Sort by Date ~

Mailboxes
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£ lan's e
=) TalkTalk 2

Medium Daily Digest
An FBI Behaviour Expert Explains

Eltima
Re: Thunderdrive

Hi lan, Thank you for reaching u
CloudMounter does not support T

¥ 3¢ VIPs
Y Alison Drew

Eltirmis

Here we show you how to open a new, blank email, write

a message and send it to a given email address using
the Mac’s Mail app. To send a new email, click on the button in
the top left corner of the screen, with a picture on it that looks
like a pen writing on paper.

t

View Mailbox Message Format Window Help

il
4
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To: James Gale ~
Cec: Mark Ayshford «
Subject: Things to discuss

From: lan Osborne - jjosborne@icloud.com

view Maillbox Message Foemat Window  Help £ &

o B O T o4 ors B

i 1af Daborng - joebornamicioud com

To send someone an email, type their email address into

the box marked To:. To also send it to someone else,
add their email address in the Cc: box. Add multiple email
addresses in either box, separated by commas, to send the
same message to a group of people.

288 < = &
James Gale
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3 It's always a good idea to put something in the subject
line, even if it's just ‘Hello!'. Type the body of your
message in the large space below. An email can be as long as
you like and you can use different fonts, colours and sizes if

you really feel the need.

Customising Mail.
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You can customise your Mail app by opening it and, in the Mail
pull-down menu, selecting Preferences. Under the General tab,
you can set an interval to check for new messages, decide
where downloaded attachments go and more.

Once you've finished typing your letter, click the Send

button in the top left corner of the email panel to send it
on its way. Email is usually sent very quickly, and your
addressee should receive it within a couple of minutes, as long
as there are no issue with their connection or provider.
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The Fonts & Colours tab lets you change the fonts and text
size used with incoming emails and change the colours of
quoted text. Explore the Mail preferences and set up how you
choose, but be careful with the server settings.




Receiving Email.

When you receive an email in your inbox, this is how
you open and read it using the macOS Mail app.
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Once you've set up your email account, you can send
and receive email. As soon as you launch Mail, it
connects to your email service and collect any email that
is waiting for you. These messages are shown as a list in
your Inbox. Click on one and it's displayed on the right.
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While Mail is running, it periodically checks the server for
new messages. You can also prompt Mail to look at the
server immediately by clicking the button in the top left of
the screen that looks like an envelope.

= lan's emails

Adding Attachments.
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Replying to & Forwarding Email

If someone you know sends you an email, you'll probably want
to reply to them. Simply click on the email so you are viewing
the text of it, then at the top of the screen you'll find a row of
three buttons. The leftmost one has a single left-pointing arrow
on it. This is the Reply button.

If you click on this you'll see a window pop up that looks a lot
like the window for a new email, but it will have the responder's
email address already in the To: box.

Mext to the Reply button is a similar button with two left arrows
on it. This is the Reply All button; use this with extreme care. If
you have been sent an email that has also been sentto a
number of other recipients, hitting Reply All will send your reply
to everyone who received the original mail. Obwviously if your
reply was meant to be private this is a very bad idea, and has
got many people into trouble.,

The rightmost button of these three is the Forward button,
which is used to send an email you've received to another
recipient. Forwarding emails is another thing that requires care,
make sure that you don't accidentally send private information
to someone who was not meant to receive it,

Almost any type of file can be attached and sent over the Internet along with your email.
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Signature:

To add an attachment, first start an email (or reply to one you
received), and then click on the button bearing the picture of a
paperclip, at the top right of the email panel. This will open a
Finder window, allowing you to navigate to the file or files that
you want to send. Select the ones you want, then click Choose
File to attach them.
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In Mail, pictures you've included as attachments are shown in
the body of the email for convenient viewing. This means you
can tum your email into a mini-illustrated article if you want; or,
if you don't want to display it as an attachment, click on it and
from the contextual menu, choose Show as Icon. It can still be
opened by the recipient.
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The Mail Markup Featur Move to...

i i — T U i) B W A i, Highlight or open an email and you see a new pull-down
menu marked ‘Move to..." in the toolbar. This lets you move
it to one of your folders including Trash, Junk, and folders
you've set up yourself. Mail also offers suggestions for
where it thinks you might want to move a mail.
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The Markup feature lets you add notes and scribbles to

pictures that are attached to an email before you send it. To
beqgin using the Mail app’s Markup feature, start writing an emai
and attach a photo to it in the usual way:

Show Only Unread Messages.

- | You can hide emails you've already read by clicking this
icon. Now only unread messages are shown. Click it again
to show all your emails once more. It's great for finding
emails that you received a while ago but haven't seen yet.

noox — lan's emails |

1%  WIPs w Sent w Drafts w Flagged
Sort by Unread

® VUE
Films showing for just £4.99 at Vue Torbay

® Affinity Team
n Spotlight: Step into the whimsical

Click on the attached image, and then click on the small

arrow that appears in the upper right corner of the
photograph. Select the Markup option to open the Mail app's
Markup feature. You can also use certain third-party apps o
edit photos this way;

= I B Flagging an Email.

a- O : To mark an email with a flag, highlighting it for later reference,
i o g SRR 5 click on the Flag pull-down and choose a colour. You can add
more than one flag to a single email. To remove them again,
choose Clear Flag. The 'Flagged’ option in the side bar
shows emails you've marked.

® GoGroopie
4 Luxury Bath Sheests OMLY £12.99 | Easy Store...

 ® =» i 3 Move to...
ts v Flagged w Orange
™ Red
™ Purple
Blue
rjust £4.99 at Vue Torbay Yellow
_ Green
You can now use the interface that appears to add text, Re. Novel
drawings, or a range of shapes and symbols directly 1 i
onto the photo, in the email erwironment. When you're 1to the whimsical world of ph & LT ZETe
finished, click the Done button and either mark up more loit shares his top tips for Toggle Flag

pictures or send your email as normal. ate hnard nama rraatnre Wan
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Mail Drop.

If you need to send large attachments via email,
the Mail Drop feature is very useful. It's really easy
to use too.

If an attachment you wish to email is too large for a regular
email, it's stored on Apple’s server and offered as a
download instead. Depending on whether the recipient is
using Mail, the attachment could appear as a download link
or as thumbnails.

Here, we received huge photos, which are displayed as
thumbnails. You can download them all by hovenng over the
email and clicking on the paperclip as shown. Theyre kept
on Apple's server for a month from the date they were sent.

Mail in Full Screen Mode.

 Mail | &

Searching Your Emails

pxis (Found 3,089 matchas Tar search)

piCtunes o
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BuDjec] Corlans: piclunes
Pictures
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Pictures Tor Valch mberveew

Pictures from Mom

Artschment name oontamna: plctur

Type your search term into the search field in the top
right. Suggestions are offered for items such as people,
subjecls and attachments; emails that meetl your search
requirements are shown in the email hst.

=X Bl
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ptches for search

0, EENEER Pictures
o Subject
Entire Message

&

B After clicking on one of the suggested items, you can
adjust your search by clicking the first word in the field
and choosing a new option, as shown here, or even adding a
second search term for more advanced searches,

The Mail app’s full-screen mode works in a different way to other apps. Here's a guide on how to use this useful feature.
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Writing or replying to an email when the Mail app is in full
screen mode involves working in a split screen view. Click on
the green gumdrop in the top left corner of the Mail app
window to take the app into full screen mode.
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>tart a new email or reply to one. The screen is split, with your
outgoing email shown on the right. Drag the dividing line to
make more room for the email app. The email's gumdrops are
shown by dragging your pointer to the top of the screen.
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Using Mail Signatures.

You can add a signature to your emails, that is, a short
piece of text that's at the foot of every email you send.
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A signature is a piece of text that you can add to the foot of
your email automatically. To set one or more up, open Mail
Preferences (from the Mail menu), click on Signatures in the
top bar and then on the account to which you wish to add a
signature in the accounts on the left. Click on the '+’ button
under the middle column to add a signature.
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You can click on the name of it in the middle column and
change it to anything you like, and write your chosen
signature in the right-hand column. It can be anything you
want. Now, when writing, forwarding, or replying to an
email, you can add or remove your signature using the
pull-down menu to the right of the From field.

Accessing Emojis.
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The Mail app has an emoji picker to use when writing an
email. Click on the smiley face in the toolbar and you get a
choice of emoji to add to your email. To add it, just click on the
one you want. Scroll up and down, or click the icons at the
bottom for more choices.
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Block Sender

To block a sender who sends you emails you don't wish to
receive, click on that person’s name in the incoming email and
select Block Sender. To stop blocked emails reaching your
inbox, in Mail Preferences, go to Junk Mail and click the Blocked
tab. Select ‘Move it to the Bin' to send emails from blocked
senders straight to the bin.
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Mute Thread

If an email exchange is throwing up too many notifications, you
can mute it by clicking on the crossed-out bell in the toolbar. The
emails still arrive as usual, but, until you unmute it again, you
won't get notifications on delivery:
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Crivation

Unsubscribe

If an incoming email is from a mailing list, the Unsubscribe link
now appears right at the top of the email. Click the Unsubscribe
link to stop this mailing list from sending you emails in the future.
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Home App
For the Smart Home

Apple’s HomeKit gave developers the means to control compatible household
gadgets from mobile devices such as the iPhone and iPad and the Home app
brought their controls together, under one application. The Home app is now
available on the Mac too, and it's just as easy to use.
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Before you can make use of the Home app, you have to When you've added one or more devices using your
add HomeKit compatible devices. You can only do this I0S device, you can access them through Home on the
from an i0OS device, you can't use your Mac. There's a list of Mac. Right-click on a device's window and select Settings and
HomekKit compatible devices online at www.apple.co/ZMFnb3, you can change the room they're assigned to.

Automation
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[
3 Click the Automation tab and you can set timers, actions For example, you can use the Home app to control and
and more. What they do depends on what kit you've configure speakers that are compatible with HomeKit.
incorporated into your Home app. Click the + icon to add Maturally, Apple's own HomeFod, pictured here, fits the bill but

automations or groups of automations (scenes). there are plenty more.
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News App
Stories and Features

Another application that comes to the Mac from 10S is the News app. It's a
great way of collating news stories and features from around the world and

presenting them in one place. When you've customised it to suit your own
particular needs, it's an amazing source of information.

0 o % News
B raes- 28 September r
D sewsges
[ Seved Sam s
0 pawtory Top Storie
Pl ag Chasen By the &pale Haws edios
=EW HEWS DO TORS" PICKS
DurrFasd UK
Flran Top Ermers Ewmu“l e
e anathar dramatic
) Techecsngy woek in British
BB BB Soes ie Frcus Magasne politics

“Ha ahou'd be sbschAsly
o Fawa i ol e

m | l....: :. :I
| e
m' " .

L
THUFFPOSTY

Prirce Harry mesis sare  Labowr Wil Bonip

bl Laedmibray whotim vigEed Tabsarvcng Sng Gt

When you first open the News app, you see a sidebar
and a main window. The sidebar's Today option is
selected, giving you a range of the day's top stories. Click on a
story to open it and read it in full.
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The Spotlight option gives you a selection of features

chosen by Apple’s editors. If you find a story you
particularly like or dislike, choose the Suggest More or Fewer
Stories Like this in the File menu to improve future suggestions.
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When you open a news story, if it has a video it can be
watched within the News app. In the File menu, there's
an option to open the story in Safan. This takes you to the web
page from which the story was drawn.

UK to ban import of
trophy hunting souvenirs
to help endangered
animals
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n In the sidebar section titled *Suggested by Siri’, you see
various subjects the News app thinks might interest you.
The stories work just like in the other sections; click one to
open it, click the chevron in the top-left to go back a page.
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In the File menu is an option called Discover Channels &
Topics. Click it for a range of news sources and subjects
for you to choose from. Click the plus sign in the corner of any
you especially like.
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In the top right corner, you can see a search field. Enter
a search term for a subject or source you're interested in
and you're given a list of individual stories, and channels,
which write about that subject.

Catalina

Information leaks
gets MacOS
Catalina arrival next

week
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If you come across a news stary you'd quite like to read
but don't have the time, select Save Story in the File
menu or type CMD-5. Click Saved Stories in the sidebar to see
the pages you've saved.
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Scroll down the window for more channels and topics.
Select as many or as few as you like. When you're
finished, click the Done button at the bottom. Your new sources

have been added to your sidebar.
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Scroll up the search results for a list of channels and topics
relating to the search, Click the plus sign to add that
channel or topic to your sidebar. To remove a channel or topic,
right-click on it and then select Unfollow,
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If you want to go back to a story you've previously read, it

can be found in the History section near the top of the
sidebar, Click this and your reading history is listed; click a story
to open it once more.
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Photos App
Manage Your Images

With the release of macOS Catalina, the
Photos app goes from strength to strength.
Once again, you can edit your snaps to
get the best from them, store them in the
app, arrange them into albums, watch
them as slideshows and even create
books, calendars, greetings cards and wall
prints. Here’'s a guide to what you can do

with the Photos app.

1 Use this button to toggle
between regular thumbnails of
your photos, as seen here, and
sguare-shaped images that leave
little border.

This slider increases and
decreases the size of your
preview images.

Use these buttons o view your

photos arranged according to
the year, month, or day in which they
were taken.

Click here to see all your

photographs in the Photos
app, arranged as thumbnails.
Double-click on a thumbnail to open
a photo.

This button opens the

information window. You can
use it by selecting a preview or
opening a photo. The information
window gives information on the
picture and the camera on which it
was taken, it also lets you add names
to the people in it.

The Share button lets you add

the picture to shared albums,
send it using Mail, AirDrop,

Messages and more, add it to Notes
or Reminders, and even set it as a
desklop picture,

7 Choose a photo and click the
Heart button to identify a
picture as one of your favourites.

Rotate the image 90%

anti-clockwise. Hold Alt to turn
it clockwise instead. Useful if a
picture that's been imported is not
the right way up.

The search field. Thanks to the

Photo app’s machine learning,
you can search for terms like
‘pirthday’, 'holiday’, "Christmas’ and
more, to find photos taken on these
oCccasions.

m These sidebar options
represent different ways of

viewing photos found in your library,
Photos shows all your photos,
Memories arranges them into
groups, Favourites shows your best
pics, and Places groups them
according to where they were taken.
Recents, Imports, and Recently
Deleted are self-explanatory.

@ Photos File Edit Imhge View Window
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Fhotos you've shared

on iCloud are listed in
Activity, and Shared Albums
shows the albums in which
they were shared. Hover over
Shared Albums and click the
plus sign to start a new,
shared album.

These are your local
albums. Media Types

Months

MacBook
BE 2 000 =

groups your pics as videos,
selfies, panoramas and more,
while the My Albums option
shows albums you've put
together yourself.
m If you put together a
nook, calendar, card,
print, wall decor, or slideshow

based on your photos, they
appear here. Apple no longer
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sells prints themselves, but
you can get apps from the
App Store for third-party
services. Hover over My
Projects and click the plus
sign to start a new project

These are the dates

between which the
currently visible pictures were
taken and the locations.
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15 Your pictures, arranged

as thumbnails. Click on
one to open it, after which you
can swipe through them or
choose one from the preview
bar under an open photo.
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Edit With.

Right-click on an open photo and you get a sub-menu.
Hover over Edit With and, if you have third-party photo
editors on your Mac, you can open the photo in one of
them and then edit it using that app. Edits are carried
over into the Photos app.

The Editing Tools
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automatically enhance your pic, or click the Edit button
to make manual adjustments. In Editing Mode, the Edit button
changes to ‘Done’. Click this when you've finished your edits.
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Click a triangle in the sidebar to open a tool. The Light, 3 Retouch removes unwanted objects from a picture.,
Colour and Black & White tools give you sliders to Click the brush, then click and drag to paint over the
increase or reduce the brightness and saturation, or switchtoa  object. Let go and it's removed. Red Eye lets you paint out
monochrome image. Click the Options triangles for more red pupils caused by camera flash. You can adjust the brush
advanced toals. size with both tools.

| Ternperabure | Tink

In White Balance, select the feature to adjust with the B In Curves, drag the diagonal line or the dots under the
pull-down and use the slider to change it. Levels take right and left ends. A useful trick is to click on the |eft
time to master. Hover your pointer over the graph and drag the dropper and click something black, then the right dropper and
dots at the foot of the vertical lines to adjust. click on something white. The Definition tool is another slider.
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lets you make adjustments to one colour at a time, using the
pickers and sliders, and Noise Reduction is for smoothing out
speckles and other such imperfections in the photo.

@ A £ crap

select the Filters tab and you can automatically add an
effect to your photo. Here we've gone for Vivid Warm but
you can also set it cooler, make it monotone and more,
Choosing another filter to overrides the last one. Choose
Original to remove all filters.

Reset Adjustments

10 Edits made in the Photos app are non-destructive. This

means whatever you've done to your picture can be
reversed. If you don't like your edits, just click the Reset
Adjustments button in the bottom right corner and your photo
reverts to its onginal settings.

Selective Colour and Moise Reduction are sliders. The former

Photos | %

The Sharpen tool lels you sharpen pictures that are out of
[ . S
focus. You can sharpen the edges, adjust the intensity and
more, The Vignette option lets you add an adjustable shadow to
the edges of the photograph, as you can see we've done here,

®;: Adist @ Filters

Use the Crop tab to rotate your photo If it isn't straight
and also to crop it by dragging the corners into the
photo. The Flip option in the sidebar mirrors the pic and
Aspect lets you resize the photo according to an aspect ratio
of your choice,

Universal Tools.

All the options in Edit Mode have these three tools,
which appear when you hover over or open one of the
settings tools. The curly arrow reverses the last
adjustment you made. Auto makes an automatic
enhancement with that tool only and the tick in a circle
toggles the last edit you did on and off, so you can see
the difference it has made.

» () Colour

-

Options

& Retouch
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Adding People
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Open a photo containing people and click the i button

for the information window. If the Photos app has
identified a face, it's shown in this window. Click it to tag the
face with the person's name. Click the plus sign to add
another tag, which you can name and move should there be
a face that isn't identified.

Projects

2 is

n You can still order prints and design books, calendars

and cards with Photos, but Apple no longer sells them.
Instead, hover over Projects and select the project you want

to start. Apps you have downloaded for the purpose are

shown, as is an App Store link taking you to extensions
offering these third-party services.

Memories

i

Click on Memories in the sidebar to show photos

grouped according to various factors, including time
and content. For example, a series of pictures taken over a
week in a certain location might be identified as a holiday,
Catalina also picks your best shots too.

Click ‘People’ in the sidebar to see photos you've

identified by name. Click on a person to see all the
photos you have of them. If a photo doesn't contain that
person, right-click on it and select the option "X is not in this
photo' to remove it. Scroll down and click Confirm Additional
Photos to check pics the app thinks are of that person.
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Choose an extension offering the project you want, and

install it. Then choose the pictures you want to import
into the project (hold CMD and click on them one by one),
then select the extension in the menu shown in the previous
step. You can then follow the instructions offered on-screen to
build and print your project.

Click on a memory and hover aver the picture at the top
to see a Play button. Click it for a slideshow. Hover over

the slideshow for controls. Click the cog to change the

background music. Right-click on a memory and you can

delete it, or add it to your favourites.
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Making New Albums iCloud Photos.
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CTRL-click on the pictures you want to make into an To share a photo with iCloud, first go to System
album, then hover aver My Albums in the sidebar. Click Preferences = Apple 1D = iCloud and make sure the
the plus sign that appears, and choose whether to make a Photos option at the top of the list is ticked. You can then
regular album, a smart alibbum, or a folder from your pictures. upload photo albums to iICloud and share them with others.
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If you choose a smart album, you can set rules. From To start a shared album, hover over the Shared
then on, any photo you add to your Photos app that Albums option in the sidebar and click the plus sign

satisfies these rules is automatically added to your smart that appears. Give your new album a name, invite people to
album. Set its title in this window too. view it and make any comments you wish.
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3 Choose a regular album and you can give it a name. 3 Go back to Photos, in the sidebar, and then drag pics
The new album appears in your sidebar; click the and videos into the new, shared album. Click the
tnangle next to My Albums to see them all. You can drag Silhouette icon, in the top bar, to invite or uninvite people and

photos onto this album to add them to it. set a few more options. People you invite get a message.
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2 Glossary of Mac and
Computing Terms

We've tried to keep this guide as jargon free as possible, but inevitably there
are some words and phrases that might still seem mysterious to the newcomer.
Where that’s the case, this glossary should help. If you're confused by a
technical term, take a look; you might just find the definition you need in here.

A

Accessibility: A series of tools
and features designed to
make an Apple device such
as the Mac and mobile
devices easier to use by
those with disabilities such
as vision or hearing
impairments. You can find
the Mac's Accessibility
features and customise them
in System Preferences.

AirPlay: A protocol for
streaming sounds and video
from an Apple device to a
set of compatible speakers,
or a device such as an
Apple TV. It's wireless, and
easy to use as well.

App: Short for "application’,
another name for a
computer software program.
Your Mac comes with a
selection of pre-installed
apps, and you can buy more
from the Mac App Store.,

App Store: The App Store is
where you can download free
and paid programs to your
device using your Apple ID.
You can access it through the
application that comes
bundled with your Mac.

Apple ID: This is the email
address and password that
you have registered with
Apple. It's required to
access many online
applications on your Mac,
including iTunes, App
Store and Books.

Apple Menu: The menu that's
opened by clicking on the
Apple icon in the left of the
menu bar. It gives access to
system functions such as
Preferences, App Store,
Force Quit and more.
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Bluetooth: Bluetooth is a
wireless technology used to
link and exchange data with
another compatible device. It
has a range of approximately
8 metres (25ft). The Mac
supports many Bluetooth
devices, including
headphones, keyboards and
fitness trackers.

Books: This is Apple's eBook
application, which is
available for free from the
App Store and is also
bundled with recent
versions of macOS. It
handles the standard
electronic publishing
formats protected by
FairPlay DRM, and also
PDF documents. It was
introduced in 2010 along

with the iPad.

Browser: An app used to
access websites found on
the worldwide web. The
Mac comes with Apple’s
Safari browser preinstalled,
but others are available in
the App Store.

C

Calendar: This is one of Apple's
preloaded apps. Use it to
keep track of events,
invitations, and reminders
on your Mac, iPhone, iPod
touch and iPad.

Closed Clamshell Mode: By
connecting your notebook
Mac to a display, an external
keyboard and a controller
such as a mouse or Magic
Trackpad, you can use it like
a desktop computer, with the
notebook closed.

D

Desktop: A computer that's
designed to be used on a desk
while plugged into the mains, at
home or in the office, as
opposed to a notebook or
laptop. Apple’s range of
deskiop computers is the iMac,
the Mac mini and the Mac Pro.

Dock: The opaque strip at the
bottom of the screen. Apps
in the dock are easy to
access and open, and you
can customise it to best suit
your requirements. Apps
that are currently running
are also shown in the dock.

E

Emoticon: A small drawing
used to augment a message
or text. Typically, these are
vellow faces showing a
variety of expressions.

F

Facebook: Currently the most
popular social networking
site on the Internet. Add
your Facebook account to
your list of Internet Accounts
in System Preferences and
you can share material
directly to it using the
macOS Share button.

FaceTime: You can make video
and audio calls to other Apple
devices using the FaceTime
app. These are made over
the Internet so are free
unless using mobile data.

Finder: The Finder is the Mac's
user interface. It deals with
management of folders,
windows, menus and more.
lts feature set has grown over
the years, with recent
introductions including tabbed
Finder windows and tags.

Folders: A folder is a container
for a group of apps or files.
You can create one by
using Finder’'s File menu, or
right-clicking on the desktop
and using the contextual
menu. You can drag items
into and out of a folder.

Force Quit: The act of forcing
an application to close
down, perhaps because it's
crashed or frozen. It's
achieved by right-clicking its
dock icon, or opening the
Apple menu and selecting
Force Quit. Unfortunately,
unsaved work will be lost.

G

Gestures: These are actions
performed with your fingers
on the Mac's trackpad.

You can use gestures on a
notebook trackpad, an
Apple Magic Trackpad or to
a limited extent, an Apple
Magic Mouse.

Gumdrops: A colloquial term for
the three coloured buttons
found in the top left corner of
an app or finder window.
They close the window (red),
minimise the window (yellow)
or switch to and from
full-screen mode (green)

H

HTML: Hypertext Markup
Language, the standard for
building websites, and a
cornerstone technology of
the worldwide web.

iICloud: The collective name for
Apple’s online services, it
replaced MobileMe and
integrates with all i0S/
iIPadOS and macOS/05 X
Mac computers.




iMessage: A text message
that's sent from one Apple
device to another.
iMessages use the Internet
rather than the mabile
phone network, so they're
sent free of charge from
iPhones and iPads.

i0S: Apple’s mobile operating
system. iOS is the software
that powers the iPhone, iPod
touch, iPad and Apple TV.

iPadOS: The latest operating
system used by the iPad. It
evolved from iO5.

iTunes: Apple's abandoned
music playing software,
which was also used to
activate and sync iPads and
I0S devices. In macOS
Catalina, iTunes was
replaced by three new apps;
Music, TV and Podcasts.

L

LaunchPad: Found in the dock
represented by a rocket
icon, the LaunchPad is an
easy way of opening apps.
It resembles and behaves
like an iI0S Home screen.

Lightning: The cable connection
used by modem iPads and
iPhones. It replaces the old
30-pin dock connectors, and
is used to charge these
mobile devices and sync
them with your Mac.

Location Services: Features
and software on your Mac
that pinpoint and use your
current location. The Maps
app is one example.

macOS: Formerly known as OS
X, macOS is the operating
system on which the Mac
runs. The current version of
macQOS is Version 10.15:
Catalina. Like most recent
versions of macOS,
Catalina is a free upgrade.

Mail: The Mac's bundled email
client. It can handle a wide
range of email accounts,
including Apple iCloud
accounts, Microsoft's and
Google's mail services,
Yahoo email accounts and
those accounts that are
provided by your Internet
Service Provider. Third party
email apps are available.

Menu Bar: The macOS Menu
Bar sits atop the desktop, at
the top of the screen. On
the left are pull-down
menus, which vary
according to what app
you're using. On the right
are menulets and controls,
along with info such as the
time and date.

Messages: One of Apple's
built-in apps that handles

SMS text messages and
MMS multimedia messages.

MMS: Multimedia Messages
(MMS) supports images,
videos, sound, contact
cards, and location data.
Sent and received via the
Messages app on the Mac
to other Macs and mobile
cell phones.

Monitor: Also called a display,
this is an external screen
that's essential for Mac
minis and Mac Pros. You
can also add a monitor to
an iMac or notebook Mac
as a second or even
primary display.

Mouse: A controller used to
move your pointer around
your Mac's screen, and to
select options using the
mouse buttons. A mouse is
traditionally used with a
desktop computer such as
the iMac or Mac Pro, but if
you don't like trackpads,
you can use one with your
notebook too.

N

Notebook: A portable computer,
sometimes called a laptop.
MNotebooks can be mains or
battery powered and have
their own built-in screen,
which folds down for
portability. Apple's notebook
range comprises of the
MacBook, MacBook Air and
MacBook Pro.

MNotification Centre: A list of
recent notifications,
accessible by clicking on
the icon in the top-right
corner of the Mac's desktop.

P

Photo Stream: Part of iCloud,
Photo Stream stores your
last thirty days or 1000
photos online and on your
i0S/iPadOS devices, and all
your photos on your Mac.

Photos: A bundled Mac
application that lets you
store, manage and edit your
photo collections and share
them with your other Apple
devices using iCloud.

Q

QuickTime: Apple's 2D video
and graphics player, used to
play movies and other video
on your Mac.

R

Retina Display: This is Apple’s
term for its high-resolution
screens. The pixels are so
small it's impossible to
distinguish between them at
a normal viewing distance,
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making the on-screen images
very smooth and clear.

S

Safari: Apple's web browser,
similar in function to
Microsoft Explorer or Google
Chrome. It's available for
both Macs and 105/iPadOS
devices, and it lets you surf
the worldwide web.

Siri: Apple's voice activated
digital assistant. You can
give Sin spoken instructions
and the service replies by
giving you the information
yvou asked for; or by
activating the requested
Mac function.

SMS (Short Message Service):
Text messages sent from
the Messages app from a
Mac's Messages app or
mobile device such as the
iIPad or iPhone to other cell
mobile phones.

T

Tablet: A computer in a flat,
‘tablet’ form factor, such as
the iPad. While the iPad is the
most popular tablet computer,
other models are available.

Text Field: Any area of the
screen where you can add
text. For example, when
completing a web form, there
are text fields for things like
your name, address and
more. Tap on a text field to
bring up the cursor, so you
can start typing.

Thunderbolt: A high-speed
connectivity port offered on
recent Macs. A Thunderbolt
port can carry a video signal
as well as data, so it can be
used for an external display.

Touch Bar: The very latest
models of the MacBook Pro
replaces the function keys
with a touch-sensitive
screen which displays
functions and controls
according to the app or
feature you're currently
using. It also has a Touch
ID fingerprint scanner for
unlocking your Mac.,

Trackpad: The controller device
used in notebook Macs. You
control your on-screen pointer
by dragging your finger across
the trackpad. Apple’s Magic
Trackpad is available for
deskiop computers.

Twitter: One of the most
popular social networks
built around a follower/
following system rather
than friends, with
messages limited to 140
characters. There's an
official Twitter app for the
Mac, and several third
party options for sending
Tweets too.

U

URL: Uniform Resource
Locator, the address used
to access a web page. For
example, Apple's URL (its
website) is www.apple.com,

USB: (Universal Serial Bus) an
industry standard for
connecting computers and
peripherals introduced in the
mid-Nineties. The latest
version, USB-C, has a
similar plug to Thunderbolt
3, and is compatible with
Thunderbolt 3 ports.

Vv

VPN: (Virtual Private Network):
This provides secure access
over the Internet to private
networks, such as the
network at your company or
school.

W

Wi-Fi: A wireless means of
getting onto the Internet or
connecting two devices. At
home, your Wi-Fi network is
established through your
router. Whilst away from
home, you might have
access to public Wi-Fi
networks like those offered
in coffee shops or libraries.

Y

YouTube: The Internet's most
popular video viewing and
sharing service. Owned by
Google, you can access
YouTube through a web
browser, or through a
dedicated app available for
the Mac, iPhone, iPad or
iIPod Touch.
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Now you’'ve got the basics
down, you can improve and
learn more essential skills in
our next guide...

TRICKS AND TIPS

Coming soon!







Discover more of
our gmdes...

MACOS
ATA

LGN casy 1o FoLLOW USER GUIDES NEW
LANDSCAPE MAKE YOUR

PHOTOGRAPHY

FOR BEGINNERS

o

MACBOOK c

FOR BEGJ’NNERS

LT X L T BT 11 & B T - TR ey - 1i - ]

PHOTOSHOP
LIGHTROOM

PHOTOSHOP
ELEMENTS

m EASY TO FOLLOW USER GLIDES
OUTDOOR
PHOTOGRAPHY

s ool H 0 w1 e LT e e B 0 Boalooulol U - I 0 Boal ]

L7307 cAsy TO FOLLOW USER GUIDES EYGETT cAsy 1O FOLLOW USER GUIDES

RASPBERRY Pl SALAXY

E4. ¥ TO FOLLOW USER GLNDES

WHATSAPP

E-"I ¥ TOFOLLOW USER GUIDES

WINDOWS 10

------

lllllllllllllllllllllllllllllllllll

el Can,,

|||||||||||||||||||||||||||||||||



Master Your Tech

@ Black Dog Media

From Beginner to Expert

To continue learning more about your Apple tech visit us at:

o0 0 0 LN

iIPhone & i0OS

EXCLUSIVE Offers

on Apple Guidebooks

@ Print & digital editions
® Featuring the latest updates

® Step-by-step tutorials & guides
® Created by BDM experts

Mac For Beginners

2nd Edition

ISBMN: 978-1-912847-07-5

Published by: Fapercut Limited

Digital distribution by:

Readly AB, Zinio, Magzter, Cafeyn, PocketMags

2 2020 Papercut Limited All rights reserved, o part of this publication
may ke reproduced in any form, stored inoa retnieval system o

any other publication, database or commercia
pragrams without the express written permission of the publisher

integrated into

Under na circumstances should this publicabion and its contents be
resald, loaned out or used in any form by way of trade without the
publisher's written permission, While we pride curselves on the quality
cf the information we provide, Papercut Limited reserves the right not
to be held respansible for any mistakes or inaccuracies found within
the text a7 this publication, Due to the nature ot the tech industry, the
publisher cannot guararntee that all apps and software will werk on
every versien of device, It remains the purchaser's sole responsibility
to determine the suitability of this book and its content for whatever
purpose, Any app images reproduced on the front and back cover
are solely for desipn purposes and are not representative of content
We advise all patential buyers to check listing prior to purchase for
confirmation of actual content. All editorial opinian herein is that of the

¥

» ultimate photoshop

bdmpublications.com/ultimate-photoshop
Buy our Photoshop guides and download tutorial
images for free! Simply sign up and get creative.

When you sign up to our
monthly newsletter!

reviewsr - 35 an individual - and is not representative of the publisher
ar any of its affiliates, Therelare the publisher holds no respansibility in
regard to editorial opinion and content.

This is an independent publication and as such does not necessarily reflect
the views or opinicns of the producers of apps or products contained
within, This publication is 100% unofficial, All copyrights, trademarks and
repistered Trademarks Tor the respective companies are acknowledped,
Relevant praphic imagery reproduced with courtesy of brands and products.
Additional images contained within this publication are reproduced uncer
icence fram Shutterstock. Prices, international availability, ratings, titles and
content are subject to change

All information was correct at time of publication. Some cortent may have
e prevoushy publshed inothersalumes ortitles

Y Fapercut Limited
= Registerad in England & Wales No: 4308513




